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Chapter 1
Introduction 1

Welcome and congratulations on your purchase of the Canon MultiPASS 
F50 or F30 (also referred to in this guide as the printer) and its 
accompanying MultiPASS Suite for Windows.

With your printer, the MultiPASS Suite enables you to perform a variety 
of tasks, such as:

❏ Printing a document
Print a document from any Windows application that supports 
printing. Define and customize print settings that affect the output of 
your printed documents. 

❏ Faxing a document (F50)
Fax a document from your PC, attaching a predefined fax cover page 
as needed. Receive faxes directly into your PC.

❏ Scanning an image
Scan documents, photographs, and other images into your PC. 

❏ Viewing and managing your document
View and manage a document that has been faxed or scanned to your 
PC.

❏ Defining printer settings (F50)
From your PC, define settings that affect fax operations of your 
printer.

System Requirements 0

To successfully install and operate the MultiPASS Suite, your system 
must meet the following minimum requirements:
Chapter 1 Introduction   1
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❏ Windows Operating System
Microsoft Windows 95, Windows 98, Windows Me, Windows NT 4.0, 
or Windows 2000

❏ Other Software
Internet Explorer 4.0 or later

Windows 95: OSR2 or later

Windows NT 4.0: Service Pack 4 or later

❏ Computer Processor
Windows 95/98/NT 4.0: An IBM or compatible computer with a 
Pentium 90 processor or higher

Windows Me: An IBM or compatible computer with a Pentium 150 
processor or higher

Windows 2000: An IBM or compatible computer with a Pentium 133 
processor or higher

❏ Memory
Windows 95/98/Me/NT 4.0: 32 megabytes (MB) of RAM. 64 MB of 
RAM or more is recommended.

Windows 2000: 64 megabytes (MB) of RAM. 128 MB of RAM or more 
is recommended.

❏ Hard Disk Space
60 MB of available hard disk space. 150 MB of available hard disk 
space is recommended.

❏ Disk Drive
CD-ROM drive, or access to one over a network connection

❏ Monitor
256-color SVGA monitor or greater

❏ Printer Cable
For parallel port connection: A shielded, bi-directional, IEEE-1284-
compatible parallel cable 6.6 feet (2 meters) in length or shorter.
2   Introduction Chapter 1
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For USB port connection (Windows 98/Me and Windows 2000): A 
USB cable 16.4 feet (5 meters) in length or shorter.

The MultiPASS Suite for Windows 98/Me and Windows 2000 
supports both parallel and USB ports.

About This Guide 0

This guide assumes you have a basic understanding of Windows. This 
includes how to start your system and navigate within the Windows 
environment. You should be familiar with common Windows terms, such 
as window, dialog box, click, and double-click. For assistance in 
familiarizing yourself with Windows, see your Microsoft Windows user 
documentation.

For this guide, generally the images of the MultiPASS Suite were taken 
using a Windows 2000 system. However, where necessary, some images 
were taken using a Windows 98 system. Images may appear slightly 
different on other supported operating systems.

Conventions Used in This Guide 0

The following types of formatting identify specific types of information 
provided in this guide.

Italicized text Used to stress the importance of a word 
or phrase, or to refer to the title of 
another guide. For example:

You cannot access the dialog box....
-or-
...the MultiPASS Suite User’s Guide....

Text in quotation marks Used to refer to the title of a section 
within the guide. For example:

...the “Installing the Software” section....
Chapter 1 Introduction   3
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Click, double-click Use of the word click or double-click 
provides instructions for selecting or 
choosing a command or option, 
generally with a mouse. For example:

Click OK to continue.

Monospaced text Used for commands you might type 
when installing the software, or system 
messages that may display on your 
screen. For example: 

A:\SETUP

Capitalization Used for all the key words in the name 
or title of an option on the screen. For 
example:

In the dialog box, click Image Type to 
set....

Other User Assistance 0

In addition to this guide, the following information is available:

❏ Online Help
Provides information online about a window or dialog box, and step-
by-step instructions for performing MultiPASS Suite tasks.

❏ Canon MultiPASS F50 or F30 User’s Manual
Provides information on how to set up and operate your printer.

❏ Quick Start Guide
Provides summarized steps for setting up your MultiPASS system.

❏ Online Reference Guide
Provides information on paper handling, copying, and maintenance.

❏ Online Fax Guide
Provides information on faxing.
4   Introduction Chapter 1
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Chapter 2
Installing and Getting Started 2

The MultiPASS Suite includes the following software components which 
are installed automatically: 

❏ Printer Driver
Enables you to print in any Windows application that supports 
printing.

❏ Fax Driver (F50)
Enables you to send a PC fax from any Windows application that 
supports printing with the fax driver.

❏ Scan Driver (ScanGear for MultiPASS)
Enables you to scan an image into your PC.

❏ My MultiPASS
Enables you to store and manage your MultiPASS documents in 
folders on your PC.

❏ MultiPASS Viewer
Enables you to view your documents stored in My MultiPASS.

❏ MultiPASS Status Monitor
Controls and tracks the activity occurring through the port to which 
the printer is connected. The Status Monitor must be running for the 
printer and MultiPASS Suite to communicate properly. Therefore, to 
ensure you have a proper communication setup, the Status Monitor is 
set during installation to automatically start each time you start 
Windows. You can later change this setting as needed.

❏ MultiPASS Toolbar
Enables you to scan an image directly to a destination, such as a 
desired application (for example your e-mail application or a graphic 
application).
Chapter 2 Installing and Getting Started   5
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If you are using Windows NT/2000, MPService (MultiPASS Service) is 
automatically created and must be running for jobs to be processed with 
the MultiPASS Suite and the printer. MPService starts automatically 
when you start your computer, even if you have not yet logged into 
Windows. If you log off Windows and leave the computer on, MPService 
continues to run, to process any MultiPASS jobs.

Installing the MultiPASS Suite 0

The MultiPASS Suite installation program installs all the appropriate 
software components on your local hard drive. The MultiPASS Suite 
should not be installed on a network drive.

MultiPASS Suite 3.x or earlier must be removed from your PC before 
installing MultiPASS Suite 4.x.

To install the MultiPASS Suite software if you are using Windows NT/
2000, you must log on as Administrator or have Administrator privileges.

When you install the MultiPASS Suite, you must choose the port type for 
the printer connection.

❏ If you are using Windows 95 or Windows NT:
You can connect the printer only to the parallel port on your 
computer. Only a parallel port connection is supported in these 
operating systems.

❏ If you are using Windows 98/Me or Windows 2000:
You can connect to the parallel port. However, if your computer has a 
USB port available, it is recommended that you connect the printer to 
the USB port. When you connect to the USB port, the parallel port on 
your printer is disabled and is not available while the USB port is 
being used.

If later you change your mind and prefer to connect to the other port, 
you must remove and reinstall the MultiPASS Suite. For instructions, 
see Chapter 7, “Changing the Port Connection.”
6   Installing and Getting Started Chapter 2
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If the MultiPASS Suite has been copied on a local or network drive, you 
can install the software on your system from that drive, rather than using 
the installation disk.

To install the MultiPASS Suite (USB port connection):
1. Turn on the printer, but do not connect the printer to your PC until 

prompted, or the PC may attempt to install the software before the 
unit is ready.

If a New Hardware Found, Update Device Driver Wizard, or Add 
New Hardware Wizard dialog box appears, click Cancel.

2. With your PC on, close any open applications (including any virus 
checkers).

3. Insert the installation disk into your disk drive.

If you are installing with a copy of the MultiPASS Suite located on 
another drive, skip to the next step.

4. If AutoRun is enabled, the installation starts automatically.

If installation does not start automatically, or you are installing from 
the software copied on another drive, do the following: 
On the Windows taskbar, click Start, and then click Run. In the Run 
dialog box, type the following command and click OK (where D: is 
the drive containing the installation disk or copied software):

D:\csplash.exe

5. When the main menu appears, click Install MultiPASS Suite.
Chapter 2 Installing and Getting Started   7
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6. On the welcome screen, click Next.

Follow the on-screen instructions.
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7. Read the License Agreement. If you agree to the terms, click Yes. If 
you do not agree, click No. You will not be allowed to continue the 
installation process.

8. When prompted, click your printer model.

9. When prompted, connect your printer cable to the ports on your 
printer and PC, so the printer can be automatically detected.

Once the cable is connected, if a system message appears indicating 
the system driver is being installed, wait until the installation process 
is completed, and then click Yes to continue.

10. Continue to follow the on-screen instructions to complete the 
installation process.

When the installation is finished, restart your PC before using the 
MultiPASS Suite software. If your PC does not restart automatically, 
restart it manually.

To install the MultiPASS Suite (parallel port connection):
1. Make sure the printer is unplugged, and the printer and PC are 

turned off. 
Chapter 2 Installing and Getting Started   9
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2. Connect your printer cable to the ports on your printer and PC.

3. Plug in your printer. Then, turn on the printer and PC.

With your PC on, close any open applications (including any virus 
checkers).

If a New Hardware Found, Update Device Driver Wizard, or Add 
New Hardware Wizard dialog box appears, click Cancel.

4. Insert the installation disk into your disk drive.

If you are installing with a copy of the MultiPASS Suite located on 
another drive, skip to the next step.

5. If AutoRun is enabled, the installation starts automatically.

If installation does not start automatically, or you are installing from 
the software copied on another drive, do the following: 
On the Windows taskbar, click Start, and then click Run. In the Run 
dialog box, type the following command and click OK (where D: is 
the drive containing the installation disk or copied software):

D:\csplash.exe

6. When the main menu appears, click Install MultiPASS Suite.
10   Installing and Getting Started Chapter 2
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7. On the welcome screen, click Next.

Follow the on-screen instructions.
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8. Read the License Agreement. If you agree to the terms, click Yes. If 
you do not agree, click No. You will not be allowed to continue the 
installation process.

9. When prompted, click your printer model.

10. Continue to follow the on-screen instructions to complete the 
installation process.

When the installation is finished, restart your PC before using the 
MultiPASS Suite software. If your PC does not restart automatically, 
restart it manually.

Setting the Default Printer 0

When you install the software, the system automatically sets the printer 
as the default printer. If necessary, however, follow these instructions to 
set the default printer.

To set the default printer:
1. On the Windows desktop, click Start, point to Settings, and click 

Printers.
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2. In the Printers window, click the printer icon.

3. On the File menu, click Set As Default (Windows 95/98/Me/NT) or 
Set as Default Printer (Windows 2000).

Sharing the Printer Installation 0

You may be using your computer and the printer connected to your 
computer in an environment where multiple computers are connected by 
a network. In this case, you can share the use of your printer with the 
other computers on the network.

If you choose to share the use of your printer, your computer acts as the 
host system or server to the other computers (also referred to as remote or 
client systems).

After you set up your printer for sharing, the client systems must install 
the printer driver onto their systems. They can do so directly from your 
system. Based on which Windows operating system you are using, the 
following client system can share your printer:

If your system (server) is: Install on client system:

Windows 95/98/Me Windows 95/98/Me

Windows NT/2000 Windows 95/98/Me or Windows NT/
2000

When a document is printed by the client system to a shared printer, any 
printing messages (status or error messages) display on the server 
system.

To set up the printer for sharing:
1. On the MultiPASS server system, on the Windows taskbar, click Start.

2. On the Start menu, point to Settings. Then click Printers.

3. In the Printers window, click the MultiPASS printer icon.

4. On the File menu, click Sharing.
Chapter 2 Installing and Getting Started   13
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If the Sharing command is not available, you need to set up printer 
sharing in Windows. For details, see your Windows user 
documentation.

5. In the Properties dialog box, on the Sharing tab, click Shared or 
Shared As.

6. In the Share Name box (Windows 95/98/Me/NT) or Shared As box 
(Windows 2000), type a name you want to assign to the shared 
printer.

If available, you may also want to assign a password, which would 
then be required by the client system when using the printer.

7. If your situation matches one of the following, set up an alternate or 
additional driver:

• Windows NT/2000 server system sharing with Windows 95/98/
Me client systems

• Windows 2000 server system sharing with Windows NT client 
systems.

For detailed instructions, see Appendix B in this guide.

8. In the Properties dialog box, click OK.

To install the printer driver on a client system:
1. On the server system, verify that the Status Monitor is running.

2. On the client system, on the Windows taskbar, click Start.

3. On the Start menu, point to Settings. Then click Printers.

4. In the Printers window, double-click Add Printer.

5. Follow the on-screen instructions.

Install the printer driver as a network printer, based on the name 
assigned to the shared printer.
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You cannot install the printer driver on a client system that has a previous 
version of the MultiPASS software (version 3.x or earlier).

Understanding the My MultiPASS Folders 4

During the MultiPASS installation, the following My MultiPASS folders 
are created, which the MultiPASS system uses to store faxes and scanned 
images:

❏ Outbox (F50)
The Outbox folder stores pending and failed fax transmissions. 
Pending fax transmissions include documents currently being faxed, 
scheduled to be faxed, or on hold. 

You can manage faxes in the Outbox using the MultiPASS menu 
commands. For more information about managing faxes in the 
Outbox, see Chapter 4, “PC Faxing (F50).” 

❏ Received Faxes (F50)
The Received Faxes folder stores received PC faxes. Received PC 
faxes are assigned a unique name with a .mlj file name extension.

Unopened received faxes are marked to indicate this status. The 
folder name is bolded, with the number of unopened faxes indicated 
in parentheses. The name of the unopened fax within the folder is 
marked with a red icon (in list view) or an asterick (*) preceding and 
following the file name (in icon or thumbnail view).

❏ Scan to Save
The Scan to Save folder stores all images you scan with the printer 
using the MultiPASS Toolbar Scan to Save button. Scanned 
documents in this folder are assigned a unique name with a graphics 
file name extension, such as .bmp, .tif, or .jpg. 

❏ Sent Faxes (F50)
After a PC fax is sent successfully, it moves from the Outbox into the 
Sent Faxes folder. Sent faxes in this folder are assigned a unique name 
with a .mlj file name extension.
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The My MultiPASS folders work within Windows Explorer, and thus 
have a similar structure. However, only the system can place documents 
into these folders. In addition, you cannot delete, move, or rename these 
folders. The folders can only be deleted by uninstalling the MultiPASS 
Suite.

You can perform basic Windows Explorer tasks to any document in a My 
MultiPASS folder, such as renaming or copying (and then pasting the 
document to another Windows folder). You can view documents as 
thumbnails, icons, or a list (sorting the list as needed). For more 
information, see your Windows Explorer documentation. However, note 
the following exceptions for the Outbox folder: 

❏ You cannot copy or paste a document in the Outbox folder.

❏  Documents always display as a list in the Outbox folder.

A document remains in a My MultiPASS folder until it is deleted by you 
or, additionally for the Outbox folder, moved by the system to the Sent 
Faxes folder.

Outbox, Received
Faxes, and Sent Faxes
folders: F50 only
16   Installing and Getting Started Chapter 2



manual.book  Page 17  Wednesday, August 22, 2001  3:44 PM
To open My MultiPASS:
Do one of the following:

❏ On the MultiPASS Toolbar, click MultiPASS.

❏ On the Windows desktop, double-click the My MultiPASS icon.

When you open My MultiPASS, the MultiPASS menu appears on the 
menu bar.

To rename a document in a My MultiPASS folder:
1. In the My MultiPASS window, under My MultiPASS, click the 

desired folder (Received Faxes, Scan to Save, or Sent Faxes folder 
only).

2. Click the desired document.

3. On the File menu, click Rename.

4. In the Rename dialog box, enter the new name for your document.

Because My MultiPASS works within Windows Explorer, as an 
alternative, you can open My MultiPASS in Windows Explorer. In 
Windows Explorer, My MultiPASS appears under Desktop.
Chapter 2 Installing and Getting Started   17
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Chapter 3
Printing 3

Once you have installed the software, you are ready to print a document 
from any Windows application that supports printing, such as Word for 
Windows. 

Your printer is initially installed using factory-predefined settings, 
enabling you to print immediately. These settings determine what your 
documents look like when printed. For example, the settings define print 
properties such as the paper size and page orientation. 

Instructions for printing a document can vary somewhat for different 
Windows applications. Therefore, for detailed instructions, see the user 
documentation for the specific application from which you are printing.

The following instructions summarize the general procedures for printing 
a document.

To print a document:
1. With your document open in your Windows application, click the 

print command. (In most applications, the print command is on the 
File menu or toolbar.)

2. In the Print dialog box, make sure the printer is selected in the Printer 
box. 

3. Click the command to print your document (usually OK or Print).

Changing Print Settings 4

The factory-predefined print settings can be changed when printing a 
particular document. For example, to suit your exact printing 
requirements, you can define settings for printing a draft copy of a report, 
and save the settings as a new print profile.
Chapter 3 Printing   19
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Unless you save your settings as a print profile, your settings are 
available only for the current print job.

Changes can be made to general quality print settings (such as media 
type), and to page setup and special effects you want to apply to your 
printed image.

You have two methods by which you can define print settings:

❏ Print Advisor
The Print Advisor displays as a wizard that guides you through a 
series of questions. Your responses enable the Print Advisor to 
automatically specify the appropriate print settings.

❏ Manually
You can manually change the individual settings to produce the most 
desirable results for your printed documents.

To change print settings using the Print Advisor:
1. In the Print dialog box when printing your document, click 

Properties. 

2. In the Properties dialog box, on the Main tab, click Print Advisor.

3. Follow the on-screen instructions.

To change print settings manually:
1. In the Print dialog box when printing your document, click 

Properties. 

2. In the Properties dialog box, on the appropriate tabs or dialog boxes, 
define your desired print settings.

3. If you are dissatisfied with your changes on a particular tab and want 
to revert to the default settings, click Defaults.

4. To accept your changes and close the dialog box, click OK.

If available, to accept your changes while leaving the dialog box 
open, click Apply.

To cancel your changes and close the dialog box, click Cancel.
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Defining Main Print Settings 4

You can define settings that determine the overall quality of your printed 
document.

To change settings on the Main tab:

❏ Media Type
Click the type of media you are printing to, such as plain paper.

❏ Paper Source
If a selection is available, click the source for feeding paper into your 
printer.

❏ Print Quality
Click the predefined print quality that best suits your document.

Stamp/Background tab:
Windows 95/98/Me/2000
only
Chapter 3 Printing   21



manual.book  Page 22  Wednesday, August 22, 2001  3:44 PM
• High
Click if you want to print your document with a higher print 
quality, which may print more slowly.

• Standard
Click to print your document with average speed and quality.

• Draft
Click if you want to print your document quickly but with a 
lower print quality. This setting is ideal for longer documents and 
proofreading purposes.

• Custom
Click to set the print quality and halftoning individually. For 
details, see the “Setting a Custom Print Quality” section.

❏ Color Adjustment
Click the preferred method for adjusting the color in your document.

• Auto
Click to have the printer driver automatically adjust the color. 

• Manual
Click to define the color adjustment manually. For details, see the 
“Setting a Custom Color Adjustment” section.

❏ Grayscale Printing
Click to print a black and white version of a color document.

The printer picture illustrates the current settings. 

Setting a Custom Print Quality 4

If the available Print Quality settings do not suit your needs, you can 
make finer adjustments to the print quality and halftone settings.

1. Under Print Quality, click Custom. Then, click Set.
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2. In the Set Print Quality dialog box, move the print quality slider to 
choose the best balance between printing speed and print quality.

3. Click the halftoning method:

• Auto Fine (Auto in Windows NT/2000)
Click to automatically change dithering and diffusion based on 
the characteristics of the image. 

• Auto Fast (Windows 95/98/Me)
When Quality is set to 5, Auto Fine changes to Auto Fast. Click to 
automatically change dithering and diffusion based on the 
characteristics of the image.

• Dither and Dither Fast (Windows 95/98/Me)
Click to arrange image pixels in a fixed pattern to create 
halftones. This setting is suitable for business charts and graphics 
with well-defined color boundaries. Dither Fast prints at a higher 
speed after performing simple dithering.

• Diffusion
Click to arrange image pixels randomly. This setting is suitable 
for photographs and graphics that require a finer color gradation.
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Setting a Custom Color Adjustment 4

Since color is generally adjusted from within your application, you 
should set the color balance here only for finer adjustments.

1. Under Color Adjustment, click Manual. Then, click Set.

2. In the Manual Color Adjustment dialog box, move the color balance 
sliders to adjust the color balance and intensity.

3. Click Enable ICM (Image Color Management) (Windows 
98/Me/2000) to activate the color correction function built into 
Windows.

4. In the Print Type box, click the type of image you are printing.

5. In the Brightness box, click a level of brightness you prefer for your 
image.
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Defining Page Settings 4

Page settings enable you to determine properties such as the overall size 
of the printed page and its contents, and how the document is oriented on 
the page. 

To change the settings on the Page Setup tab:

❏ Page Size
Click the size of the page you are printing, which matches the page 
size specified in the Windows application. To specify a custom size 
paper, click Custom or Custom Size. For details, see the “Defining a 
Custom Paper Size” section.

❏ Orientation
Click to determine how your document is printed on the page: 
Portrait to print the contents of your document vertically on the page, 
or Landscape to print the contents of your document horizontally on 
the page.

Stamp/Background tab:
Windows 95/98/Me/2000
only
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❏ Printer Paper Size
Based on the printing type you select, click the size of the paper on 
which you want to print. To specify a custom size paper, click 
Custom or Custom Size. For details, see the “Defining a Custom 
Paper Size” section.

❏ Printing Type
Click the type of printing you want to use for your document.

• If your page size and printer paper size are different, click Fit-to-
Page Printing (Windows NT/2000) to automatically print your 
document to fit the printer paper size.

• If you want to enlarge or reduce the printed document, click 
Scaled Printing.

• If you want to print more than one page on a single sheet of paper 
(for example, to conserve paper for reviewing the draft copy of a 
report), click Page Layout Printing. 

If you are using Windows NT, you are now set up to print two 
pages on a single sheet.

If you are using Windows 95/98/Me/2000, see the “Printing 
More Than One Page on a Single Sheet (Windows 
95/98/Me/2000)” section for details.

• If you want to print your image as a poster, click Poster Printing 
(Windows 95/98/Me/2000). For details, see the “Printing a 
Poster (Windows 95/98/Me/2000)” section.

• If you want to print your image or document as a banner, click 
Banner Printing. For details, see the “Printing a Banner” section.

❏ Scaling
If you selected Scaled Printing as your printing type, click, or type, 
the percentage to enlarge or reduce the print size of your document.

❏ Copies
Click or type the number of copies you want to print.
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❏ Reverse Order (Windows 95/98/Me/2000)
If you are printing a multiple page document, click to print pages in 
sequence, starting with the last page. The result is the pages of the 
document are stacked in the proper order. 

❏ Collate (Windows 95/98/Me/2000)
If you are printing multiple copies of a multiple page document, click 
to print all pages of the document before the next copy is printed. 
When not selected, each page is printed for the specified number of 
copies before the next page is printed.

Defining a Custom Paper Size 4

You can specify a custom size for the page size or printer paper size.

1. In the Page Size or Printer Paper Size box, click Custom or Custom 
Size. 

2. In the Custom Paper Size dialog box, click a unit of measure, and 
specify the width and height.

Printing More Than One Page on a Single Sheet 
(Windows 95/98/Me/2000) 4

If you want to print more than one page of your document on a single 
sheet of paper, do the following:
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1. In the Printing Type box, click Page Layout Printing. Then, click 
Specify.

2. In the Page Layout Printing dialog box, in the Pages box, click the 
number of pages you want to print on a single sheet.

3. To rearrange the printing order of the pages, in the Page Order box, 
click the desired position.

4.  To print a border around each page, click Page Border.

Printing a Poster (Windows 95/98/Me/2000) 4

You can print a single image divided across several sheets of paper. When 
the printed sheets are pasted together, they form a poster. The number of 
divisions determines the number of printed pages, and thus the overall 
size of the poster. You can also print text in the margins that serve as 
guidelines for pasting the poster together.

1. In the Printing Type box, click Poster Printing. Then, click Specify.
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2. In the Poster Printing dialog box, under Image Divisions, click the 
number of pages on which to print the poster.

3. Click if you want the words “Cut” and “Paste,” cut lines, or both 
printed in the margins as guidelines.

Printing a Banner 4

When printing a banner, be aware of the following limitations:

❏ You can print a document as a banner on banner paper from two to 
six sheets in length.

❏ Banner printing consumes large quantities of ink. You will not be able 
to change an ink tank during printing, so check the ink supply before 
printing, and load a new ink tank if needed.

❏ In your Windows application for your document, make sure the 
number of copies to print is set to 1. Banner printing does not operate 
properly if you specify more than one copy.

❏ When Banner printing is selected, certain print options may be 
unavailable.

To prepare your printer for banner printing:
1. Cut the banner paper one sheet longer than the document requires.
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2. Insert the banner paper into your printer. Make sure the printed 
surface faces up. 

3. Press down gently on the sheet until paper feeding starts.

To set your banner printing options and print your banner:
1. In the Printing Type box, click Banner Printing.

2. If the banner printing message box appears, click OK.

3. In the Printer Properties dialog box, click OK.

4. In the Print dialog box click the print command (usually OK or Print). 
If you are prompted to accept your printing options, click OK.

Using Printer Control (Windows 95/98/Me) 4

You can define settings that control certain print operations.

1. On the Page Setup tab, click Printer Control.

2. In the Printer Control dialog box, click Background Printing if you 
want printing to continue in the background while you process other 
work on your PC. 

3. If you selected Background Printing, click Print During Spooling if 
you want printing to start while the document is being sent to the 
print queue. Otherwise, printing will not begin until the entire 
document is sent to the queue.
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Using Stamps and Backgrounds 
(Windows 95/98/Me/2000) 4

You can add stamps and background images to your printed documents. 
The software contains a library of images to use as stamps or 
backgrounds, stored as .bmp files, that were installed with the software. 
You can also define a stamp or background of your own.

For example, you may want to use a stamp that designates the status of 
the document, such as confidential or a draft version.

To use a stamp:
1. In the Printer Properties dialog box, on the Stamp/Background tab, 

click Stamp and then click a stamp in the list.

2. To print the stamp over the text in your document, click Place Stamp 
Over Text.

Stamp/Background tab:
Windows 95/98/Me/2000
only
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To preserve the readability of your printed document, clear this 
setting to print the text of your document over the stamp.

3. To print the stamp only on the first page of your printed document, 
rather than all the pages, click Stamp First Page Only.

To use a background:
1. In the Printer Properties dialog box, on the Stamp/Background tab, 

click Background and then click a background in the list.

2. To print the background on the first page only, rather than all the 
pages, click Background First Page Only.

Creating or Changing a Stamp or Background 4

You can change the settings of a predefined stamp or create one of your 
own. When creating or changing a stamp, you define its various 
characteristics, such as the text and font. After defining stamp settings, 
you can save the stamp for later use.

Once you select a background image from the factory-predefined list or 
by importing one, you can define the settings for the background. 

To create or change a stamp:
1. On the Stamp/Background tab, do one of the following:

• To change an existing stamp, click Stamp and then click the name 
of the stamp in the list.

• To create a new stamp, clear Stamp.

2. Click Define Stamp.

3. In the Stamp Settings Properties dialog box, on the appropriate tabs, 
set your desired options.

To define the text and color of a stamp (Windows 95/98/Me):
1. On the Text tab, enter the stamp text.
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2. Specify the font characteristics, such as type, style, size, and outline.

3. On the Color tab, under Palette, click an available color shown in the 
palette. 
Chapter 3 Printing   33



manual.book  Page 34  Wednesday, August 22, 2001  3:44 PM
4. If you want to customize a stamp color, under Palette, click the color 
that is closest to your desired custom color. Then, click Detailed Color 
Adjustment.

5. Move the slider for each of the listed colors until you have reached 
the desired mix for your custom color.

6. If you want to save the custom color in the palette, click Add to 
Palette. The newly created color is added to the last row on the color 
palette. If the last row has been filled with custom colors you created 
previously, you can choose to replace the earliest existing custom 
color.

To define the text and color of a text stamp (Windows 2000):
1. On the Stamp tab, click Text for the Stamp Type.
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2. In the Stamp Text box, enter the stamp text.

3. Specify the font characteristics, such as font type, style, size and 
outline.

4. Click Select Color to change the color of your stamp text.
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5. In the Color dialog box, under Basic Colors, click an available color.

6. If you want to customize a stamp color, under Basic Colors, click the 
color that is closest to your desired custom color. Then, click Define 
Custom Colors.

7. Move the slider, or enter the color values, until you have reached the 
desired mix for your custom color.
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8. If you want to save the custom color in the Custom Colors palette, 
click Add to Custom Colors. The newly created color is added to the 
Custom Colors palette. If the Custom Colors palette is filled with 
custom colors you created previously, the earliest existing custom 
color is replaced.

To define the image for a graphic stamp (Windows 2000):
1. On the Stamp tab, click Bitmap for the Stamp Type.

2. Click Select File. 
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3. In the Open dialog box, specify the path and filename for your 
graphic. Then, click OK.

4. On the Stamp tab, move the Size slider to the left to decrease the size 
of the graphic, right to increase.

5. Click Transparent White Area to make the white areas in the graphic 
transparent.

To define the placement of a stamp:
On the Placement tab, specify the following settings:
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❏ Position
Click the desired placement on the page. If you want to define your 
own placement, click Custom. Then, in the X-Position and Y-Position 
boxes, click or type the X-position and Y-position coordinates for the 
position of the stamp.

You can also click the stamp in the page illustration on the left and 
drag the stamp to the desired position on the page.

❏ Orientation (Text Stamp)
Click or type the number of degrees to specify the angle of rotation of 
your stamp. A negative number of degrees rotates the stamp 
clockwise. A positive number of degrees rotates the stamp counter 
clockwise.

To save a stamp:
1. On the Save Settings tab, in the Title box, enter a name for the stamp.

Values for X-Position and
Y-Position may vary with 
the operating system 
Chapter 3 Printing   39



manual.book  Page 40  Wednesday, August 22, 2001  3:44 PM
2. Click Save.

3. When prompted, confirm that you want to save the stamp.

To delete a stamp:
1. On the Save Settings tab, click the stamp in the list that you want to 

delete.

2. Click Delete.

When prompted, confirm that you want to delete the stamp.

To select and define a background:
1. On the Stamp/Background tab, do one of the following:

• To change the properties of an existing background, click 
Background and then the name in the list.

• To select a new background image, clear Background.
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2. Click Select Background.

To select a new background image:
1. In the Background Settings Properties dialog box, on the Background 

tab, click Select File.

2. In the Select Image File (Windows 95/98/Me) or Open (Windows 
2000) dialog box, specify the path and file name for the graphic that 
you want to use as the background image. Then, click OK.

To define the properties of the background:
1. In the Background Settings Properties dialog box, make sure the 

name of the graphic you want to change displays in the File box.

2. On the Background tab, specify the layout method for the 
background image. If you want to define your own layout position, 
click Custom.

3. If you selected Custom as your layout position, in the X- and Y-
Position boxes, click or type the desired coordinates.

4. Under Intensity, move the slider to lighten or darken the background.

  
 

Values for X-Position and 
Y-Position may vary with the
operating system 
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To save a background:
1. In the Background Settings Properties dialog box, click the Save 

Settings tab.

2. In the Title box, enter a name for the background. Then, click Save.

3. When prompted, confirm that you want to save the setting.

To delete a background setting:
1. In the Printer Properties dialog box, on the Stamp/Background tab, 

click the background you want to delete in the Background list.

2. Click Select Background.

3. In the Background Settings Properties dialog box, click the Save 
Settings tab.

4. In the Title box, confirm the background setting you want to delete 
appears. Then, click Delete.

5. When prompted, confirm that you want to delete the setting.
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Defining Special Effects 4

You can set effects to make images appear more interesting, such as 
making a photograph resemble a drawing or changing the colors of an 
image to monochrome.

To change the settings on the Effects tab:

❏ Simulate Illustration
Click to convert full-color and 256-color images into a simulated 
hand-drawn illustration. When Simulate Illustration is selected, the 
Contrast option enables you to adjust the image contrast using the 
slider.

❏ Monochrome Effects
Click to display full-color and 256-color images in a single, or 
monochrome, color. Then, click the desired color from those listed.

Stamp/Background tab:
Windows 95/98/Me/2000
only
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To set a custom monochrome effect, click Select Color. In the Color 
box, move the slider to set a custom color.

❏ Image Optimizer
Click to smooth the jagged edges in graphics and photos that have 
been enlarged by your application. This feature is also useful when 
printing low-resolution images from Web pages.

❏ Photo Optimizer PRO
Click to correct problems with images taken with a digital camera or 
acquired by a scanner. It is specifically designed to compensate for 
color shift, underexposure, and overexposure.

❏ Apply Throughout Page
If you selected Photo Optimizer PRO and there are multiple images 
on a page, click if you want the effect applied to all images.

Saving Your Settings As a Print Profile 4

If you use certain print settings frequently, you can save these settings as 
a print profile to use for printing future documents. A print profile can be 
easily retrieved for use at any time. The settings associated with the 
profile are then applied to the options on the Main, Page Setup, and 
Effects tabs.

When a print profile is no longer needed, you can delete it. The factory-
predefined profiles (Current Settings and Default Settings) cannot be 
deleted.

After using a custom print profile, you can restore the settings on the 
Main, Page Setup, and Effects tabs to their factory-predefined settings.

To save a print profile:
1. Specify your desired print settings on the Main, Page Setup, and 

Effects tabs.

2. Click the Profiles tab.
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3. Click Add to Profiles.

4. In the Add to Profiles dialog box, in the Name box, enter a name for 
the profile.

5. In the Icon box, click an icon to associate with the profile.

Stamp/Background tab:
Windows 95/98/Me/2000
only
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6. Enter a description of the profile.

To retrieve and use a print profile:
1. On the Profiles tab, in the Printing Profiles list, click the desired 

profile.

2. Click Retrieve from Profiles. When the confirmation message 
appears, click OK.

To delete a print profile:
1. On the Profiles tab, in the Printing Profiles list, click the profile.

2. Click Delete. When the confirmation message appears, click OK.

To restore the factory-predefined settings:
1. On the Profiles tab, in the Printing Profiles list, click Default Settings.

2. Click Retrieve from Profiles. When the confirmation message 
appears, click OK.

To change the default print settings, before actually printing a document, 
do the following: On the Windows desktop, click Start, point to Settings, 
and then click Printers. In the Printers window, click the printer icon. On 
the File menu, click Document Defaults (Windows NT) or Printing 
Preferences (Windows 2000). In the Printer Default dialog box (Windows 
NT) or the Printing Preferences dialog box (Windows 2000), on the 
appropriate tabs, specify your changes and click OK.

The following tabs provide standard Windows options for your printer 
driver: General, Ports, Sharing, and Security in Windows NT/2000, 
Scheduling in Windows NT, and Advanced and Color Management in 
Windows 2000. For details about these options, see your Windows user 
documentation.
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Chapter 4
PC Faxing (F50) 4

With your printer, you can send and receive faxes from and to your PC. 
You can also set up an Address Book, containing fax and e-mail 
information for people to whom you often send faxes. To assist you in 
managing your faxes, a Fax Log maintains a record of every fax you send 
or receive.

Before sending a PC fax, confirm that you have specified a unit name and 
fax number for your printer in the Device setup. For more information, 
see Chapter 7, “Fine-tuning the MultiPASS Suite.”

Sending a Fax from Your Computer 
(PC Faxing) 4

You can send a PC fax from any Windows application that supports 
document printing using the fax driver.

The MultiPASS Suite sends the PC fax to the Outbox, where progress is 
tracked until it is actually transmitted. If you specified multiple 
recipients, an individual fax job for each recipient is generated. Once 
transmitted, the fax is placed in the Sent Faxes folder. A record of the sent 
fax is also recorded in the Fax Log. If a fax fails (for example, because of 
an incorrect fax number), it remains in the Outbox until you attempt to 
resend it or delete it.

You can send a fax as an e-mail message if you have a Messaging 
Application Program Interface (MAPI)-compliant application installed. 
The e-mail application must be set up as the system default MAPI client. 
For details, see your e-mail application documentation.
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To send a PC fax:
1. With the document you want to fax open in a Windows application 

(such as Word), click the Print command. (In most Windows 
applications, the command is on the File menu or toolbar.)

2. In the Print dialog box, click Canon MultiPASS FAX in the Printer list, 
and then click OK.

3. In the Send Fax dialog box, on the Send FAX tab, enter the required 
recipient information: recipient’s name and fax number or e-mail 
address. Then, click Add to Recipient List.

• A maximum of 150 recipients can be added.

• When you enter a fax number, you use the actual numeric 
characters plus any valid characters that separate the different 
segments of the number. For example, you can use 0 through 9, 
dash (-), and parentheses (). For a complete list of valid 
characters, see Appendix A.
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In addition, you must enter any necessary dialing prefixes. For 
example, in some businesses, dialing 9 before the phone number 
may be necessary to obtain an outside line. Thus you would enter 
the fax number as 9xxx-xxxx; where xxx-xxxx is the phone 
number.

• When you enter your contact’s e-mail address, you enter it for 
reference only. However, if you have a MAPI-compliant e-mail 
application installed on your system (as described earlier in this 
chapter), you can use the e-mail address to transmit a document 
as an e-mail message. 

4. Specify your Send As setting. Click Fax if you want to send the 
document as a fax; otherwise, click Email.

5. Process the job.

• Click Send Now to send the fax now. The fax document is sent to 
the Outbox until it is transmitted. Once transmission is complete, 
the fax is moved to the Sent Faxes folder.

• Click Send Later to schedule the fax for sending later.

• Click Hold to store the fax until you decide to send or delete it. 
Held faxes are stored in the Outbox. Any fax information you 
specified is preserved.

If you clicked Send Later, to schedule the fax:
In the Send Later dialog box, select the desired date and time.
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The fax is sent to the Outbox folder for processing at the specified date 
and time.

Specifying a Fax Recipient from the Address Book 4

In addition to entering recipient information directly into the Send Fax 
dialog box, you can specify a fax recipient from the Address Book. This 
prevents you from having to re-enter the information of recipients that 
you often send faxes to.

In addition, in the Send Fax dialog box, you can make recipient 
information that you enter directly available for future use by adding the 
recipient to the Address Book. If you do not add the recipient to the 
Address Book, the information is available only for the current fax. 

To specify a recipient from the Address Book:
1. In the Send Fax dialog box, on the Send FAX tab, click Display 

Address Book. 
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2. In the Select Recipient From Address Book dialog box, select the 
desired recipient in the Recipients list and click Add to Recipient List. 
Then click OK.

3. If the entry you added has both a fax and e-mail address, the entry is 
automatically added with the fax number. If you want to send the fax 
as an e-mail message instead, in the Send Fax dialog box, on the Send 
FAX tab, in the Recipient list, right click the recipient. Then, on the 
displayed menu, click Email.

To add a recipient to the Address Book:
1. In the Send Fax dialog box, on the Send FAX tab, enter the recipient 

information in the Name, Fax, and Email boxes.

2. Click Add to Address Book.

3. The required information you entered in the Send Fax dialog box is 
automatically inserted on the appropriate tabs in the Properties 
dialog box.

Optionally, enter any other desired information. Then click OK.
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You can also click the Add to Address Book button without first entering 
the recipient information in the Send Fax dialog box. In this case, when 
the Properties dialog box appears, at a minimum enter the recipient’s 
name and fax or e-mail address. Then click OK.

For more information about setting up the address book, see the “Setting 
Up the Address Book” section later in this chapter.

Attaching and Previewing a Cover Sheet 4

As desired, you can attach a cover sheet to your fax. Before sending the 
fax, you can preview the attached cover sheet. You can select from a 
number of predefined cover sheet styles. On the cover sheet, you can 
specify sender information and memo text for your fax.

To attach a cover sheet:
1. In the Send Fax dialog box, click the Cover Sheet tab.
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2. On the Cover Sheet tab, click Use This Cover Sheet for All My Faxes. 
Then, click a cover sheet style in the list.

3. Enter the sender’s information in the Name, Fax Number, and Phone 
Number boxes. Optionally enter the sender’s company name in the 
Company box.

4. In the Memo box, optionally enter a memo to display on the cover 
sheet.

To preview a cover sheet:
With the desired cover sheet selected, click Preview.

The cover sheet displays in the Viewer. This display is read only and 
cannot be edited.

To print a cover sheet:
1. With the cover sheet open in the Viewer window, click Print on the 

File menu or toolbar.

2.  In the Print dialog box, specify your printing options.

Defining Fax Settings 4

You can change your preferred fax settings, such as paper size and 
orientation of your fax. The settings you define, including cover sheet 
settings and send to information, is used for the current fax, as well as 
future faxes.

To define fax settings:
1. In the Print dialog box, click the Fax Options tab, or click Properties.
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2. On the Fax Options tab or dialog box, specify the preferred fax 
settings.

Creating and Sending a Quick Fax 4

A Quick Fax is a brief, one-page fax sent directly from My MultiPASS. 
You specify the fax information as described in the previous sections of 
this chapter.

To create and send a Quick Fax:
1. In My MultiPASS, click Send Quick Fax on the MultiPASS menu.
54   PC Faxing (F50) Chapter 4



manual.book  Page 55  Wednesday, August 22, 2001  3:44 PM
2. In the Send Fax dialog box, on the Send FAX tab, specify your 
recipient information as described in the previous sections. 
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3. On the Cover Sheet tab, select a cover sheet and specify your sender 
information. 

4. Because the fax memo is not originating from a document created in 
another Windows application, enter the memo message in the Memo 
box.

5. After completing the entries in the Send Fax dialog box, click Send 
Now.

Working with Fax Jobs in the Outbox Folder 4

The Outbox folder stores the active fax currently being sent, queued 
faxes, faxes that were stopped from being sent, faxes that failed during 
sending, faxes that are scheduled for later, and faxes that were put on 
hold. You can perform a variety of tasks to these faxes.
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To view a fax:
Click the fax you want to view, and then click Open on the MultiPASS 
menu. Or, double-click the job.

When opened, the fax document displays in the Viewer, but cannot be 
edited.

To stop the active fax:
Click the active fax, and then click Stop on the MultiPASS menu.

To delete a fax:
1. Click the fax you want to delete. To select all the faxes, click Select All 

on the Edit menu.

2. Click Delete on the File menu, or press the Delete key.

3. When prompted, confirm that you want to permanently delete the 
fax.

To send, resend, hold a fax, or change fax information:
1. Click the desired fax. 

2. If you clicked the active or a scheduled job, click Stop on the 
MultiPASS menu.

3. With the appropriate fax selected, click Resend on the MultiPASS 
menu.
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4. In the Send Fax dialog box, change any fax information as needed on 
the Send Fax tab.

You can change the information that you initially entered for the PC 
fax. Additionally, you can add a new cover sheet to the fax.

5. Click Send Now, Send Later, or Hold.

Receiving a Fax 4

All incoming faxes are received by your printer. The incoming faxes can 
be uploaded to the Received Faxes folder in My MultiPASS, based what 
you specified for the MultiPASS Receive Fax settings. (For more 
information about Receive Fax settings, see Chapter 7, “Fine-tuning the 
MultiPASS Suite.”)

You can receive a fax regardless of whether your computer is turned on 
or off.

❏ If the computer is on and the Status Monitor is running
If your computer is turned on and the Status Monitor is running 
when the printer receives a fax, the fax is either printed directly from 
the printer or uploaded to the My MultiPASS Received Faxes folder. 

❏ If the computer is off or the Status Monitor is not running
If your computer is turned off or the Status Monitor is not running 
when the printer receives a fax, the fax is either printed directly from 
the printer, or saved in printer memory. 

If your computer is going to be off for a long time, or you are 
expecting many incoming faxes, it is recommended that you set the 
printer to automatically print incoming faxes. This setting enables 
you to leave the computer off for a long time, and still be assured of 
receiving your faxes. You can always later scan a printed fax into the 
My MultiPASS Scan to Save folder. 
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If you set the printer to save a fax in memory, it can later be printed or 
sent to the My MultiPASS Received Faxes folder when your 
computer is turned on. When a fax is saved in printer memory, a 
notification message appears on the printer LCD display, indicating 
the fax is received in a file.

To move received faxes from printer memory to My MultiPASS:
1. Turn on your computer and start Windows.

2. Open My MultiPASS.

In Device Setup, on the Receive Fax tab, the When Computer Is On option 
must be set to Send to PC.

Automatically Forwarding Received Faxes 4

If you are going to be away from your computer for a long period of time, 
you can have faxes automatically forwarded to you at a remote location. 
You specify the specific fax number to which all faxes are forwarded. 
Faxes are forwarded to you for as long as the Auto Forward setting is 
enabled. 

When you automatically forward faxes, color faxes are forwarded as 
black and white documents.

The following requirements must be met for the Auto Forward feature to 
work correctly:

❏ The PC must be on. Standby or Sleep mode must be inactive.

❏ The MultiPASS Status Monitor and MultiPASS Service (Windows 
NT/2000) must be running.

❏ In the Device Setup, on the Receive Fax tab, the When Computer Is 
On option must be set to Send to PC.

To setup fax forwarding:
1. On the MultiPASS menu, click Auto Forward.
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2. In the Auto Forward dialog box, click Enable Auto Forward and 
specify your auto-forwarding options.

• Click the device that you want to automatically forward your 
faxes.

• Enter the desired fax number.

• Click to add a cover sheet.

• Select whether to limit the number of pages of each automatically 
forwarded fax.

If you clicked Add Cover Sheet, to configure the cover sheet:
1. Click Configure.
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2. In the Configure Auto Forward Cover Sheet dialog box, click the 
cover sheet style to use.

3. In the Sender and Recipient boxes, enter the sender and recipient 
information that applies to all forwarded faxes.

4. In the Notes Field box, optionally enter memo text. The text displays 
on the cover sheet each time a fax is forwarded.

To disable fax forwarding:
1. On the MultiPASS menu, click Auto Forward.

2. In the Auto Forward dialog box, clear Enable Auto Forward.
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Using the Fax Log 4

The Fax Log contains a list of fax activity (faxes sent and received) for 
both PC and machine faxes. Each fax lists historical information, such as 
transmission status, date and time the fax was sent or received, the sender 
and recipient of the fax, and the number of pages. You can use the Fax 
Log for a variety of purposes, such as reviewing the status of a sent PC 
fax. Entries in the Fax Log cannot be opened in the Viewer. Fax Log 
entries remain in the Fax Log until you delete them or for the duration 
that you specified in the Options setup. The Fax Log does not record fax 
transmissions sent as e-mail messages. 

To display the Fax Log:
In My MultiPASS, on the MultiPASS menu, click Fax Log.

To print the Fax Log:
1. In the Fax Log dialog box, click Print.

2. In the Print dialog box, specify the desired print options.

To delete an entry in the Fax Log:
Click the entry you want to delete. Then, click Delete.
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Setting Up an Address Book 4

Using an address book can make sending a PC fax quicker and easier. 
When set up, the address book contains a list of names, fax and phone 
numbers, and e-mail addresses for contacts to whom you send PC faxes. 
You can also use address book entries for defining speed dial assignments 
for your printer.

The MultiPASS Suite uses a Windows address book (.wab) file for your 
contact information. When you first decide to use an address book, you 
designate whether you want to set up the WAB file directly in My 
MultiPASS or use a previously set up WAB file provided with Windows. 
Whichever WAB file you designate, you can use My MultiPASS to add 
and edit any contact information. If you choose to set up an address book 
in My MultiPASS, you can later change your designated WAB file and 
use a different address book for MultiPASS.

To designate the address book to use:
1. On the Windows Desktop, click Start, point to Programs, point to 

Canon MultiPASS Suite, and then click Canon MultiPASS Address 
Book Profile.

2. In the Setup Windows Address Book dialog box, click if you want to 
create the address book file in MultiPASS or if you want to use an 
existing address book file.

If you click to use an existing address book file, you will not have an 
opportunity later on to create a separate address book file directly in 
MultiPASS.

3. If you clicked to use an existing WAB file, and the system detects 
more than one file available, click the desired file in the list box.
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4. Click OK.

5. In the Address Books dialog box, click OK.

To open the address book you designated:
In My MultiPASS, on the MultiPASS menu, click Address Book.

Working with the Address Book 4

The address book contains the following types of entries: 

❏ WAB Contact
Contact entries enable you to identify each individual to whom you 
frequently send PC faxes. Once entered, you can quickly specify the 
recipients of a PC fax by selecting them from the address book.
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❏ WAB Distribution List
Distribution lists identify two or more contact entries to whom you 
repeatedly send the same PC fax. For example, you may want to 
setup a distribution list to include those contacts involved in a 
particular business project. When you specify the distribution list 
entry as the fax recipient on your PC fax, the PC fax is sent to each 
contact in the list. If you specify more than one distribution list 
address for a fax, and the distribution lists contain the same contacts, 
the duplicate contacts are automatically removed. 

You can add, edit, search for, and delete both entry types.

To add a contact:
1. In the Address Book dialog box, click New.

2. In the New Entry dialog box, click WAB Contact, and then click OK.
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3. In the Properties dialog box, enter the following required 
information:

• First name and last name

• Fax number (home or business) or e-mail address.

To edit a contact entry:
1. In the Address Book dialog box, click the entry to edit in the Recipient 

list, and then click Properties.

2. In the Properties dialog box, make the desired changes.

To add a distribution list entry:
1. In the Address Book dialog box, click New.
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2. In the New Entry dialog box, click WAB Distribution List, and then 
click OK.

3. In the Properties dialog box, in the Group Name box, enter the name 
of the distribution list. 

4. To add members to the group, do one of the following. 

• Click Select Members to add existing address book contacts to the 
group.
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• Click New Contact to create a new contact for the group.

5. Do one of the following:
68   PC Faxing (F50) Chapter 4



manual.book  Page 69  Wednesday, August 22, 2001  3:44 PM
• If you clicked Select Members in the previous step, in the Select 
Group Members dialog box, in the Address Book list, click the 
individual entry you want to add to the group, and then click 
Select. When you have added all the desired members, click OK.

• If you clicked New Contact in the previous step, in the Properties 
dialog box, enter the new member’s information and click OK. 
Repeat this step for each individual that is not in your Contact 
list.

6. To remove an entry from the group, click the name in the Distribution 
list, and then click Remove.

7. Click OK to add your new group to your address book.

To edit a Distribution List entry:
1. In the Address Book dialog box, in the Recipient list, click the 

Distribution List entry to edit. Then click Properties.

2. In the Properties dialog box, make the desired changes.
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To search for an entry in the address book:
Enter the name of the contact you want in the Search box. If an entry 
exists with that name, it is selected.

You can only search through entries by name, you cannot search using 
any other entry characteristic.

To delete an address book entry:
Click the name in the list. Then click Delete, or press the Delete key. If 
prompted, confirm that you want to delete the entry.

Designating a Different Windows Address Book 4

You can designate to use a different Windows address book file for 
MultiPASS, from the one you previously designated. You can change the 
designated WAB file as needed.

To change the designated Windows address book for MultiPASS:
1. On the Windows Desktop, click Start, point to Programs, point to 

Canon MultiPASS Suite, and then click Canon MultiPASS Address 
Book Profile.

2. In the Address Books dialog box, click Windows Address Book, and 
then click Edit.
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3. In the Add/Edit Windows Address Book dialog box, enter a name for 
your WAB file.

4. Click Browse. In the Select WAB File dialog box, specify the path and 
name of the .wab file you want to use. Then, click OK.

Once designated, you open and use the Windows address book file as 
described in a previous section of this chapter. 

As an Alternative: Importing Your Address Book
You can import the entries from one Windows address book file into 
another, combining both sets of address book entries (for example, import 
from the address book created directly in MultiPASS to an existing 
Windows address book). The following summarizes the procedure for 
importing the entries. For details on importing the entries, see your 
Windows user documentation.

On your system, search for the appropriate .wab files (for example, the 
address book file created in MultiPASS and the existing Windows 
address book file). Using Windows commands, open the Windows 
address book file into which you want to import entries. Then, import the 
entries from the other Windows address book file. 
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Chapter 5
Scanning 5

You can use the printer to scan documents by the following methods:

❏ Using the MultiPASS Toolbar
The MultiPASS Toolbar (also referred to as the Toolbar) enables you 
to scan a document or image into your PC. The appearance of the 
Toolbar can change based on the settings (such as shown buttons and 
size) you define for the Toolbar.

❏ Using a TWAIN-compliant Windows application
You can use the printer to scan documents directly into a Windows 
application that supports a TWAIN interface (such as Photoshop). 
Some applications allow multiple page scans, while others do not. If 
you are unsure whether your Windows application supports this 
feature, refer to the user documentation for the application you are 
using.

When you scan a document, the system uses predefined settings that 
determine the characteristics of your scanned image (such as the image 
type and resolution), enabling you to begin scanning immediately. 
However, you can change these settings as needed.

To scan an image with the Toolbar:
1. Place your image facedown on the platen glass, or load it in the 

automatic document feeder (F50), of your printer.

Only one sheet can be scanned if you plan on scanning with the 
Photo, Text, Custom1, Custom2, or Custom3 button (see next step). 
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2. On the Windows desktop, on the MultiPASS Toolbar, click the 
appropriate scan button.

• Click Fax to scan your document and automatically send it as a 
fax from your PC (F50).

• Click Mail to scan your document and automatically attach it to a 
message in your e-mail application.

• Click Save to scan your document and automatically save it in the 
My MultiPASS Scan to Save folder.

• Click Photo to scan your document and automatically have it 
display in a graphic application (such as MultiPASS Viewer).

• If the buttons appear on the Toolbar, click Text, Custom1, 
Custom2, or Custom3 to scan your document and automatically 
have it display in an application you assigned in the Toolbar 
settings (such as OmniPage or Microsoft Paint).

3. If the ScanGear window appears, define your scan settings as desired 
and scan your document. 

For details on setting the ScanGear window to appear, see the 
“Defining Toolbar Settings” section. For details on defining scan 
settings, see the “Working with Scan Settings in ScanGear” section.

If the ScanGear window does not appear, skip to the next step.

4. When the scan is complete, do one of the following:

• If you clicked Fax in Step 2:
In the Send Fax dialog box, enter the appropriate information and 
send the fax.

• If you clicked Mail in Step 2:
In the e-mail message window, enter the appropriate information 
and send the e-mail message.
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• If you clicked Save in Step 2:
The image file is automatically saved in My MultiPASS, in the 
Scan to Save folder.

• If you clicked Photo in Step 2: 
The image automatically appears in the associated graphic 
application.

• If you clicked Text, Custom1, Custom2, or Custom3 in Step 2: 
The image automatically appears in the software application set 
up as the linked application in your Toolbar settings.

To scan an image from a TWAIN-compliant Windows application:
1. Place your image facedown on the platen glass, or load it in the 

automatic document feeder (F50), of your printer.

2. In your Windows application, click the command to scan a document.

In some applications, the appropriate command may be listed as 
Acquire or Acquire Image.

3. In the ScanGear window, specify the preview scan options for your 
document as necessary.

4. Click Preview.

5. Review the display of your scanned preview image. Adjust the 
properties of the image as necessary.

6. If you loaded your document into the automatic document feeder in 
Step 1, replace your document in the automatic document feeder.

7. Click Scan.

When complete, the image appears in the display area of your Windows 
application.
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Working with Scan Settings in ScanGear 6

When you use ScanGear before scanning, typically you scan a preview of 
the document first. The preview image enables you to review the results 
of your scanned image and make any necessary adjustments (for 
example, to size, tone, and so on). When you are satisfied with the results, 
you then perform the final scan of the document.

The following instructions summarize the procedures for scanning an 
image with ScanGear.

To scan an image in ScanGear:
1. In the ScanGear window, click whether you want to work in Simple 

Mode or Advanced Mode.

2. On the appropriate tabs, specify the desired preview scan settings for 
your image, such as the color mode, scan resolution, and page size.

3. Click Preview.

4. Review the display of the scanned preview image. Adjust the 
properties of your image as necessary.

5. With your document in the printer, click Scan to perform the final 
scan of your image.

Defining Preview Scan Settings in Simple Mode 6

Simple Mode enables you to use a more simplified screen, providing 
basic but fewer choices, in defining the scan settings for the preview 
image. You choose an image type that determines the predefined color 
mode and resolution for scanning your image. You can define and delete 
custom image types as needed.
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To define preview scan settings in Simple Mode: 
1. On the Simple Mode tab, in the Image Type box, click the type of 

image you are scanning, which automatically sets the color mode and 
resolution.

2. In the Paper Size list, click the size of the source document or image 
you are scanning.

3. In the Width and Height lists, click the unit of measure by which you 
want to display the dimensions of your selected paper size.

4. In the Image Source list, click where you placed the source image you 
are scanning.

To define a custom image type:
1. In the Image Type box, click Custom.

2. Click Edit Image Type.
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3. In the Image Type Settings dialog box, enter a name for the image 
type you are defining.

4. Click the preferred color mode and resolution.

5. Click Save.

To delete a custom image type:
1. In the Image Type box, click the name of the image type you want to 

delete.

2. Click Edit Image Type.

3. In the Image Type Settings dialog box, click Delete.

4. When prompted, click Yes to delete the image type.

Defining Preview Scan Settings in Advanced Mode 6

In addition to defining scan settings similar to Simple Mode, Advanced 
Mode enables you to adjust the preview image before the final scan. 
These adjustments can include setting the tone and brightness of your 
scanned image. 

To define preview scan settings in Advanced Mode:
1. On the Main tab, click the color mode for your image. 
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2. Click or type the resolution, as dots per inch (dpi).

If you are using the platen, in addition to the available settings in the 
box, you can enter 4800, 7200, or 9600 as the resolution.

3. On the Preferences tab, set the following:

• Text Enhanced Instead of B&W
Click to use with OCR (Optical Character Recognition) software. 
This setting increases the contrast in black and white scanning to 
promote the accurate recognition of characters in OCR software. 
Resolution should be at least 300 dpi for OCR scans.

If selected, the text enhanced setting is used for applications that 
request a black and white scan and do not use the scan window 
(including most OCR applications).

• Canon ColorGear Color Matching
Click to enable your system to show an image in colors that best 
represent the original, based on the display characteristics of your 
monitor.

Since results can vary, it is recommended that you experiment 
scanning your image with this option turned on and off. Results 
can vary based on the type of image you are scanning and the 
output of your final scan.
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• Change Monitor Profile
If the appropriate monitor profile is not displayed, click to change 
your monitor profile. Then, in the displayed list, click your 
monitor. If your monitor is not listed, click Canon’s Default 
Profile for Monitors.

Since the quality of your scanned image could be affected if the 
correct monitor profile is not selected, changing the monitor 
profile enables a better quality scanned image. 

4. On the F50 tab (F30 tab), click where you placed the source image you 
are scanning:

5. In the Paper Size list, click the size of the source image you are 
scanning.

Adjusting the Preview Image for Final Scan 6

Once an image has been previewed, you can adjust the image and the 
area in which it is viewed.

To resize a preview image, to better view its details:
1. On the toolbar, click Zoom.

2. To enlarge the view, left-click the mouse pointer on the image. 

To reduce the view, right-click the mouse pointer on the image.

To move an enlarged image:
If the image is too large to see in its entirety, on the toolbar, click Scroll 
and drag the zoomed image to display the appropriate section.
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To reverse the tone of an image:
On the toolbar, click Negative/Positive.

To create a mirrored view of your image:
On the toolbar, click Flip.

To rotate the image 90o left or right:
On the toolbar, click Rotate Left or Rotate Right to change the orientation 
of the image.

To display rulers in the preview area:
On the toolbar, click Rulers to work more precisely with a preview image, 
by displaying rulers on the top and left borders of the preview area.

To remove the current preview image:
Click Clear if the preview image does not serve your purpose.

To reduce the moire pattern in the preview image:
In Advanced Mode, on the F50 (F30) tab, click Descreen.

If you are scanning at a higher resolution, the descreen process may take 
several minutes to complete.

Cropping Your Preview Image 6

You can crop your preview image by selecting only that portion of the 
image that you want. Then, when you rescan the image, only that portion 
of the image appears. 

There are different methods available for cropping your image.

To automatically crop the image:
Click Auto Crop. Click repeatedly to reduce the size of the cropped area.

You can manually resize and reposition the cropped area, as explained in 
the following procedure.

To manually define the cropped area:
1. Click Advanced Mode.
Chapter 5 Scanning   81



manual.book  Page 82  Wednesday, August 22, 2001  3:44 PM
2. On the Main tab, if you want to maintain the current width and 
height proportions of the image while cropping, click Keep 
Proportions.

3. Do one of the following:

• To draw the cropped area:
Click Select. Position the mouse point at the upper left corner of 
the area you want to select, and drag the mouse to the lower right 
corner of the desired area.

• To define the cropped area by its size:
In the Width and Height boxes, type the appropriate dimensions.

4. To resize the cropped area, do one of the following:

• In the Width and Height boxes, type the appropriate dimensions.

• Drag any sizing handle on the crop border.

5. To reposition the crop border, place the mouse cursor inside the 
border and drag to the appropriate area.

6. If you want to clear the current selection, click outside the crop 
border. 

7. To preview the cropped image, click Preview.

Scaling the Image Output Size 6

You can scale the size of your preview image, to maintain the image size 
while enlarging or reducing the output size. For example, if you scale 
your image by 50%, the output size of the image is half the size of the 
actual image size.

To set an image scale:
On the Main tab, in the Scale box, enter a percentage.
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Adjusting the Tone of a Color or Grayscale 
Image 6

If you selected Color or Grayscale as your color mode, you can produce a 
wide range of visual effects or corrections in your preview image by 
adjusting the settings on the Tone tab. The tone settings can be adjusted 
using the following methods.

To automatically correct the tone:
Click Auto on the ScanGear toolbar or the Tone tab.

To adjust the contrast or brightness of an image:
1. On the Tone tab, click Contrast/Brightness.

2. If you are working with a color image, click the appropriate color 
channel.

3. Move the Contrast and Brightness sliders to the left for less contrast 
or brightness, and to the right for more contrast or brightness.
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4. To return to the original setting, click Reset.

To adjust the tone with the gamma value:
1. On the Tone tab, click Gamma.

2. If you are working with a color image, click the appropriate color 
channel.

3. Move the slider to the left to decrease, to the right to increase, the 
contrast displayed in the middle of the tonal range (midtones) of your 
image. Or, enter the value in the box.

4. To return to the original setting, click Reset.

To adjust the tone using a histogram:
1. On the Tone tab, click Histogram.
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2. If you are working with a color image, click the appropriate color 
channel.

3. For the black-point, midpoint, or white-point, do one of the following 
to make a change:

• Click the appropriately labeled button. Then click the portion of 
the image in the preview area that is darkest (for black-point), 
lightest (for white-point), or in the middle of the tonal range (for 
midpoint).

• Drag the appropriate arrow at the bottom of the histogram to the 
level you want.

When you adjust the black-point, all tones in the image darker than 
the selected black-point are adjusted to black.

When you adjust the midpoint, all tones in the image between the 
black-point and the white-point are adjusted to the selected mid-
point.
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When you adjust the white-point, all tones in the image lighter than 
the selected white-point are adjusted to white.

4. To return to the original setting, click Reset.

To save the histogram setting:
1. Click Save. 

2. In the Save As dialog box, specify the file name and location where 
you want to save the setting, and click Save.

To open a previously saved histogram setting:
1. Click Load.

2. In the Open dialog box, click the file name for the tone setting you 
want to load and click Open.

To correct a common tone problem with a predefined tone curve:
1. On the Tone tab, click Special Tone Curves.

2. If you are working with a color image, click the appropriate color 
channel.
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3. In the Select Special Curve box, click the desired correction.

4. To return to the original setting, click Reset.

Adjusting the Tone of a Black and White 
Image 6

If you selected Black and White as your color mode, you can define the 
following tone settings on the Black & White tab.

❏ Options
Click the method that produces the most desirable results for your 
black and white image, based on how the method represents the 
black and white portions of your image. To better understand how 
each method affects the black and white portions of your image, it is 
recommended that you select each method in turn and preview the 
results in the sample image.
Chapter 5 Scanning   87



manual.book  Page 88  Wednesday, August 22, 2001  3:44 PM
❏  Brightness
Move the slider to the left to decrease the brightness, to the right to 
increase the brightness. Or, enter a value in the box.

Although the Black & White tab appears when you select Text Enhanced 
as the color mode, the settings are not available and cannot be changed.

Adjusting ScanGear Preferences 6

In addition to scan preferences you can set prior to scanning a preview 
image (described previously), you can adjust other preferences for 
ScanGear that affect the scan behavior the next time you scan an image.

To adjust scan behavior preferences:
1. In Advanced Mode, click the Preferences tab. 

2. Under Preview at Opening of ScanGear, click whether or not you 
want ScanGear to automatically scan a preview of the image in your 
printer, or to display the previous preview image.

3. Since not all Windows scan applications may close the ScanGear 
window automatically, click if you want to ensure that ScanGear will 
automatically close after the final scan is complete.
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Defining Toolbar Settings 6

You can define settings on the Toolbar that affect the behavior of the scan 
buttons and other general settings.

To change the scan button settings:
1. On the Windows desktop, on the MultiPASS Toolbar, click Settings.

2. In the Toolbar Settings dialog box, click the appropriate tab for the 
scan button whose settings you want to change (for example, 
Custom1).

3. On the appropriate tab, make your preferred changes:

• Show This Button on Toolbar
Click to display the button associated with this scan destination 
on the Toolbar. If this option is cleared, the button does not 
appear on the Toolbar.

Illustration of
Custom tab.
However, the
options on each
tab are very 
similar.
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• Link To
On the Scan to Fax tab, this setting displays the fax driver that is 
used to send your scanned document as a fax.

On the Scan Text, Scan Photo, and Custom tabs, this setting 
displays the path and executable file for the application 
associated with the scan destination. The Scan Text and Scan 
Photo buttons may be factory-predefined with an application 
bundled with your MultiPASS Suite. For example, the Scan Text 
button may be linked to the OmniPage application 
(omnipage.exe). The Custom tabs enable you to associate your 
preferred applications with the Custom buttons.

• Set
On the Scan to Fax tab, click to change the fax options used when 
faxing the scanned document with the Fax button. In the FAX 
Properties dialog box, specify your changes (such as paper size) 
and click OK.

On the Scan Text, Scan Photo and Custom tabs, click to associate 
an application with this scan button (for example, Microsoft 
Paint). In the Select Application dialog box, click the path and file 
name for the application executable (.EXE) file. Then click Open.

• Image File
On the Scan to Save tab, click Browse to select a location (drive 
and folder) where you want your image files to be saved. The 
factory-predefined setting is the Scan to Save folder in My 
MultiPASS.
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• Filename and Numbering
On the Scan to Save tab, in the Filename box, enter the base file 
name you want to use to define your own preference for naming 
files. For Numbering, click whether you want to continue 
numbering from the previously saved file, or to begin the 
numbering from the specified number.

MultiPASS uses a naming rule for automatically assigning file 
names to scanned images that are saved as files. This rule 
includes a base file name plus a sequential number. 

For example, if you enter SavedScan as the base file name, and 
you specify the numbering to start at 100, your subsequent image 
files would be named: SavedScan100, SavedScan101, and so on.

• Save as Type
If available, click the file format in which you want your scanned 
image saved, such as BMP or TIF. This option is available only for 
those scan destinations where saving the image file is 
appropriate.

• Image Type
If available, click the type of image you are scanning, such as 
Black and White.

• Image Quality (Resolution)
If available, click the resolution (in dots per inch, dpi) for the 
image you are scanning. A higher resolution results in a better 
image quality, but may take longer to scan. A lower resolution 
generally scans faster, but may generate a lesser quality image.

• Paper Size (if available)
Click the physical size of the image being scanned, such as letter 
or business card size. 

If you want to specify a custom paper size, click Custom. Then, 
click the unit of measure by which you want to define your 
custom paper size. In the Width and Height boxes, enter the 
dimensions of your custom paper size.
Chapter 5 Scanning   91



manual.book  Page 92  Wednesday, August 22, 2001  3:44 PM
• Width and Height
Click the unit of measure to display the dimensions of the paper 
size you selected.

To change general Toolbar settings:
1. On the Windows desktop, on the Toolbar, click Settings.

2. In the Toolbar Settings dialog box, click the Toolbar Settings tab.

3. Specify your changes:

• Image Source
Click the printer you prefer to use for scanning.

Then, if a selection is available for that particular printer, click 
where you prefer to place the original image for scanning.
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• When Scanner Push Button Pressed
Click the desired action that occurs when you push the scan 
button on your printer. For example, you can set the button to 
display the Toolbar, or to send the scanned document to a 
particular destination, such as fax.

• Show ScanGear Before Scanning
Click to display the ScanGear window when you scan a 
document. When the ScanGear window is displayed, you can 
adjust scan settings.

If this option is cleared, the image is scanned based on the scan 
settings defined in the Toolbar.

• Toolbar Always on Top
Click to keep the Toolbar displayed on top of all applications that 
may appear on the Windows desktop.

• Load on Windows Startup
Click to open the Toolbar when Windows is started. If this setting 
is cleared, you need to open the Toolbar when you want to use it.

• Button Size
Click your preferred display size for the Toolbar buttons.

Viewing the Toolbar 6

If the Toolbar does not automatically open, you will need to open it when 
necessary. Under certain circumstances, you may be required to close the 
Toolbar (for example, when removing the software). The display of the 
Toolbar can also be minimized or maximized on the Windows taskbar or 
desktop.

To open the Toolbar:
On the Windows desktop, click Start, point to Programs, point to 
MultiPASS Suite, and then click MultiPASS Toolbar. Or, double-click the 
MultiPASS Toolbar icon on the Windows desktop.
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To close the Toolbar:
On the Windows taskbar, right-click the Toolbar icon. On the displayed 
menu, click Exit MultiPASS Toolbar.

To minimize the Toolbar open on the desktop:
On the Toolbar, click the Close button on the title bar.

To maximize the Toolbar from an icon on the taskbar:
Double-click the Toolbar icon.

As an alternative for performing some of the tasks described for the 
Toolbar (such as scanning to a particular destination), you can use the 
Toolbar menus. To do so: On the Windows taskbar, click or right-click the 
Toolbar icon. On the displayed menu, click the desired command.
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Chapter 6
Viewing and Enhancing Images 6

You can open and view documents stored in the My MultiPASS folders 
with the MultiPASS Viewer (also referred to as the Viewer).

Once open in the Viewer, if you want to edit your document, you can 
open it in the MultiPASS Photo Enhancer (also referred to as the Photo 
Enhancer). The Photo Enhancer enables you to make advanced image 
adjustments, such as applying filters or effects to your images.

Since the appearance and behavior of both the Viewer and Photo 
Enhancer are very similar, many of the procedures in this chapter are 
used for working with documents in either application.

To open a document in the Viewer:
In the My MultiPASS folders, click the document, and then click Open on 
the File menu. Or, double-click the document.
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To close the Viewer:
On the File menu, click Exit.

To open an image in the Photo Enhancer:
1. Open the document that you want to edit in the Viewer.

2. Click Edit on the Viewer toolbar or Tools menu.

Documents containing metadata can be opened with the Photo Enhancer. 
However, if the document is edited and saved, all metadata is lost.

To close the Photo Enhancer:
On the File menu, click Exit.

Specifying Display Preferences 6

While working with a document, you may want to modify the display of 
the document or Viewer window layout area to suit your needs. 

To page through a multipage document:
1. Open your multipage document in the Viewer or Photo Enhancer.
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2. In the Viewer:
On the View menu, point to Page. Then, click to the next, previous, 
first, or last page. Or, on the toolbar, click Previous Page or Next Page.

In the Photo Enhancer:
On the Page toolbar, click to the previous, next, first, or last page. 

For a specific page, click Goto Page. Then, in the Goto Page dialog 
box, enter the page number.

To move through the images in a My MultiPASS folder (Viewer):
1. Open an image from the My MultiPASS folder you want to page 

through.

2. On the View menu, point to Image. Then, click to the next, previous, 
first, or last image. Or, on the toolbar, click Previous or Next.

To adjust the magnification of the document or image:
In the Viewer or Photo Enhancer, do one of the following:

❏ On the Zoom menu or toolbar, click to zoom out or in, decreasing or 
increasing the magnification, by increments.

❏ On the Zoom menu, click a specific setting.

• In the Viewer, display the image at its full size, resized so that the 
entire image fits the window, resized so the image width fits the 
window (while maintaining the aspect ratio for the height), or 
resized so the image height fits the window (while maintaining 
the aspect ratio for the width).

• In the Photo Enhancer, display the image resized so that the 
entire image fits the window, or at its full size.

To save the desired display size (Viewer):
On the Zoom menu, click Lock.
Chapter 6 Viewing and Enhancing Images   97



manual.book  Page 98  Wednesday, August 22, 2001  3:44 PM
Once locked, each image opens using the same size.

To scroll through a zoomed document (Viewer):
Drag the mouse pointer to move your view of the image.

To scroll through a zoomed image (Photo Enhancer):
1. On the toolbar or Edit menu, click Scroll.

2. In the image layout area, drag the mouse pointer to move your view 
of the image.

To view the document in full-screen mode (Viewer):
On the View menu, click Full Screen. 

The document displays as the only item on the screen.

To return from full-screen to the regular window view (Viewer):
1. Right-click anywhere in the document. 

2. Clear Full Screen. 

To hide or show the toolbar or status bar (Viewer):
On the View menu, do one of the following:

❏ To toggle the toolbar on or off, click Toolbar.

❏ To toggle the Status bar on or off, click Status Bar.

Manipulating a Document or Image 6

You can perform a variety of tasks that affect your document image, such 
as printing, reloading, and changing the orientation of your document; 
flipping the image on a horizontal or vertical axis; and rotating the image 
clockwise or counter-clockwise by selected increments.

To print a document (Viewer):
1. On the File menu or Viewer toolbar, click Print.

2. In the Print dialog box, specify the desired print options.
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To print documents in a folder as thumbnails (Viewer):
1. Open a document in the folder that you want to display thumbnails 

of.

2. On the File menu, click Print Thumbnails.

3. In the Print dialog box, select the printer and click Print. The 
thumbnails display in the Preview window.

4. In the Print Setup dialog box, specify your print settings:

• Click, or type, the margins you want to use along the edge of the 
paper.

• If the one or more thumbnail images do not fill the page, click 
where on the paper the body of thumbnails should be positioned.

• Click the size you want to use for the thumbnails. To keep the 
width and height properly proportioned, click Maintain Aspect 
Ratio. Then, enter the appropriate width or height.

• Click other information you may want shown on the printed 
document.
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• Click the preferred resolution for the printed document. 
Generally, the higher the resolution, the higher the print quality. 
However, print speed may be slower.

• Click if you want to correct the image’s brightness and contrast 
(gamma). Then, specify the gamma value.Generally, the higher 
the value, the higher the correction to produce a more subtle 
brightness and contrast.

To change the print setup (Viewer):
1. On the File menu, click Print Setup.

2. In the Print Setup dialog box, make the desired changes:

• Click, or type, the margins you want to use along the edge of the 
paper.

• If the image does not fill the page, click where on the paper the 
printed image should be positioned.
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• Click how you want the image sized. To specify a size, click 
Specified Size. To keep the width and height properly 
proportioned, click Maintain Aspect Ratio.Then, enter the 
appropriate width or height.

• Click other information you may want shown on the printed 
document.

• Click the preferred resolution for the printed document. 
Generally, the higher the resolution, the higher the print quality. 
However, print speed may be slower.

• Click if you want to correct the image’s brightness and contrast 
(gamma). Then, specify the gamma value.Generally, the higher 
the value, the higher the correction to produce a more subtle 
brightness and contrast.

To flip an image (Photo Enhancer):
1. On the toolbar or Edit menu, click Flip.

2. In the Flip dialog box, click the Horizontal or Vertical Flip button.

To rotate a document or image:
1. Do one of the following:

• In the Viewer, on the toolbar or Tools menu, click Rotate.
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• In the Photo Enhancer, on the toolbar or Edit menu, click Rotate.

2. In the Rotate dialog box, click the Rotation button that corresponds to 
the direction you want to rotate the document or image.

3. Click Rotate All Pages or Rotate All Pages of This Image if you want 
to rotate all the pages in the document.

To reload a document or image:
Do one of the following:

❏ In the Viewer, on the View menu, click Reload.

❏ In the Photo Enhancer, on the File menu, click Revert.

Reloading a document replaces the current document with the most 
recently saved version of the document.
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Saving Documents and Images 6

You can save your documents to preserve the changes you made. If the 
document you are saving is a multipage .tif or .mlj file, you can save each 
page in the document as a separate image. The system assigns unique 
names to each of the individually saved documents. For example, a three 
page document originally named File.tif would become three separate 
documents named File-0001.tif, File-0002.tif, and File-0003.tif. 

In addition, when saving an image as a .jpg or .tif image, you can change 
the options that apply to the image file type.

To save a document or image:
1. On the File menu, click Save As.

2. In the Save Image As dialog box, specify the Windows folder where 
you want to save the file.

3. Enter a name for the file in the File Name box.

4. Click a file type in the Save As Type list.

5. If you are working with a multipage document, click if you want to 
save only the currently selected page, or each page as a separate 
image (.mlj and .tif file types only).
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6. If you selected the .jpg or .tif file type, click Options to specify save 
settings for your file.

If you selected .jpg as the save as type, and clicked Options:

1. In the JPEG Options dialog box, move the Image Quality slider or 
enter a value to specify the desired compression. 

Move the slider to the left for more compression and less image 
quality, to the right for more quality and less compression.

2. Click the appropriate Encoding. 

• Progressive
Click to create an image that displays progressively in a Web 
browser. The image displays as a series of overlays, enabling 
viewers to see a low-resolution version of the image before 
downloading it completely. Progressive .jpg files are not 
supported by some browsers and require more RAM for 
Viewing. 

• Optimize Huffman Codes
Click to optimize the color quality of the image while making a 
slightly more compressed file. Optimized .jpg images are not 
supported by some Web browsers. 
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• Store Exif Thumbnail
Click to create a preview thumbnail for the image. Preview 
thumbnails appear as icons on the desktop and in file lists (when 
the view is set to Large Icons). Selecting this option will increase 
the file size of the saved image. This option is available only if 
you clicked Optimize Huffman Codes.

3. Select whether to use color component sampling.

If you select color component sampling, the color accuracy of your 
image is slightly reduced, resulting in a smaller image file size. If 
color accuracy is more important than image size, you should not use 
color component sampling.

4. Click Save These Settings as the Defaults if you always want .jpg 
images saved in these settings.

 If you selected .tif as the save as type, and clicked Options:

1. In the TIFF Options dialog box, click the desired compression type. If 
you do not want to compress the image data, click None.

• CCITT Group 3
Click if your image is black and white and you want to optimize 
viewing in PDF or PostScript language file formats. 
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• CCITT Group 4
Click to compress the file more than CCITT Group 3. Use this 
technique if you want to achieve the same goals as CCITT Group 
3, while compressing the image more.

• Deflate
Click if your image contains large areas of a single color. This 
technique is supported by the PDF file format, but is not 
supported by all .tif file format readers.

• JPEG
Click for continuous-tone images (such as photographs) that you 
want to compress, but save in the .tif file format. This technique is 
supported by both the PDF and PostScript language file formats.

2. Click Save These Settings as the Defaults if you always want .tif 
images saved in these settings.

Specifying Viewer Preferences 6

You can set the Viewer window and photo editor preferences. You can 
also set the current document as the desktop wallpaper.

If desired, you can make the Viewer the default viewing application for 
some image types, such as jpg or tiff. When you open an image of the 
specified type located anywhere on your system, it opens in the Viewer.

To specify and save Viewer window options:
1. On the Viewer toolbar or Tools menu, click Options.
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2. In the Options dialog box, specify whether to show or hide Viewer 
window attributes, such as the toolbar, or status bar.

3. Specify your Viewer window background preferences. Click a color 
from the color list or browse to an image to be used for the Viewer 
window background. 

4. Specify your window position options.

• Click Change Window Size to Fit Image if you want the Viewer 
Window to automatically shrink to fit the displayed image.

• If you clicked Change Window Size to Fit image, you can also 
click Center Window When Auto-sizing to center the Viewer 
window after the window is resized.

• Click Automatically Save Window Position if you want to save 
the Viewer window position for the viewing of future images.

5. Specify your window attributes.

• Click Always On Top if you want the Viewer window to stay in 
the forefront of other windows.
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• Click Hide Mouse Cursor in Full-screen if you want the mouse 
cursor to disappear when viewing a document in full-screen 
mode.

To make the Viewer the default viewing application for some image 
types:
1. On the Tools menu, click File Associations.

2. In the File Associations dialog box, select the desired image file types.

To set the current document as the desktop wallpaper:
On the Tools menu, point to Set Wallpaper, and then do one of the 
following:

❏ Click Centered to center a single document image on the desktop.

❏ Click Tiled to tile multiple document images to fill the desktop area.

To restore the previous desktop wallpaper:
On the Tools menu, point to Set Wallpaper, and then click Restore.
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Specifying a Photo Editor 6

The MultiPASS Photo Enhancer is the default photo editor for the Viewer. 
However, you can setup another photo editor (such as Paint Shop Pro) as 
the default editor. To add a third-party editor, it must be installed on your 
system.

To add a photo editor:
1. On the Viewer toolbar, click the Edit arrow button. Then, click 

Configure Editors.

2. In the Configure Photo Editors dialog box, click Add.
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3. In the Browse for Photo Editor Application dialog box, locate the 
executable file for the editor you want to add, and then click Open.

4. In the Configure Photo Editor dialog box, change the application 
name as needed. Then, click OK.

To specify a different default photo editor:
1. On the Viewer toolbar, click the Edit arrow button, and then click 

Configure Editors.

2. In the Configure Photo Editors dialog box, click the photo editor that 
you want, and then click Set As Default. 

To edit the properties of the associated photo editor:
1. On the Viewer toolbar, click the Edit arrow button. Then, click 

Configure Editors.

2. In the Configure Photo Editors dialog box, select the photo editor to 
edit, and then click Edit.

3.  Make the desired changes to the name and/or location.

To remove a photo editor:
1. On the Viewer toolbar, click the Edit arrow button. Then, click 

Configure Editors.

2. In the Configure Photo Editors dialog box, select the photo editor that 
you want to remove, and then click Remove.
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Enhancing Your Images (Photo Enhancer) 6

You can perform a variety of image enhancing tasks with your images in 
the Photo Enhancer.

To resize an image:
1. On the toolbar or Edit menu, click Resize.

2. In the Resize dialog box, if you want to maintain the original image 
proportions, click Maintain Aspect Ratio.

3. Click or enter the dimensions of the new size in the Width or Height 
boxes.

4. Click the desired resampling filter. Changing the pixel dimensions 
(and therefore display size) of an image is referred to as resampling. 
The Lanczos setting generally gives the best quality to the resized 
image.

When you resize a file, you permanently alter the file by changing the 
number of pixels used to represent it. 

To crop an image:
1. On the toolbar or Edit menu, click Crop.

2. Drag the mouse pointer so that the area you want is framed, and then 
double-click the area.
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When you crop an image you cut the selected area out of the base page of 
the current image. 

To adjust the image type:
On the Color menu, click the desired image type (such as Truecolor or 
Black and White).

To adjust color balances (Truecolor image types):
1. On the toolbar or Adjust menu, click Color Balance.

In the Color Balance dialog box, the original image appears on the 
left. As you modify the image, you can see the results on the right.

2. Move the sliders to the left to decrease, to the right to increase. Or, 
enter the desired value in the appropriate box.

• When you adjust the hue, you adjust the shade or tint of colors in 
the image. Hue is measured on a circular spectrum running from 
red to green to blue and returning to red. 

• When you adjust the saturation, you adjust the purity of the hue. 
A color with 100% saturation is bright and vivid, and a color with 
0% saturation is a shade of gray. 
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• When you adjust the lightness, you adjust the brightness of the 
color. A color with 100% lightness is always pure white, and a 
color with 0% lightness is always pure black. 

To automatically adjust color levels (Truecolor, 256 Grays image types):
On the Adjust menu or toolbar, click Auto Levels.

The system automatically adjusts the color level for better viewing with 
your computer monitor or other output device.

To manually adjust color levels (Truecolor, 256 Grays image types):
1. On the toolbar or Adjust menu, click Levels.

In the Levels dialog box, the original image appears on top. As you 
modify the image, you can see the results on the bottom.

2. Move the sliders to the left to decrease, to the right to increase. Or, 
enter the desired value in the appropriate box.

• When you adjust the black point and white point levels, you 
specify what you want the darkest and lightest points in the 
range to be when you change the brightness and contrast.
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• When you change the brightness and contrast, you set the values 
in the specified black point and white point range.

• When you change the gamma, you adjust the mid-tones of the 
image to increase its contrast and enhance the overall image. 
When you increase the gamma value, light areas are made lighter, 
and dark areas are made darker.

To blur an image (Truecolor image types):
1. On the toolbar or Filter menu, click Blur.

In the Blur dialog box, the original image appears on the left. As you 
modify the image, you can see the results on the right. 

Images appear with a blur value of 50. Because the modified image 
cannot be made clearer than the original, specifying a blur value of 
less than 50 does not affect the modified image. 

2. In the Blur dialog box, specify the desired value or move the slider to 
the left for less blur, right for more blur.

When you blur an image, you average the color values of adjacent pixels, 
removing peaks, to make the image smoother.

To sharpen an image (Truecolor image types):
1. On the toolbar or Filter menu, click Sharpen.
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In the Sharpen dialog box, the original image appears on the left. As 
you modify the image, you can see the results on the right.

Images appear with a sharpen value of 50. Because the modified 
image cannot be made less sharp than the original, specifying a 
sharpen value of less than 50 does not affect the modified image. 

2. Move the slider to the left to sharpen less, to the right to sharpen 
more. Or, specify a value in the Amount box.

When you sharpen an image, you increase the difference between color 
values of adjacent pixels, sharpening the appearance of a color or 
grayscale image.

To remove noise (despeckle) from an image (Truecolor image types):
On the toolbar or Filter menu, click Despeckle.

When you despeckle an image, you remove image noise while preserving 
detail. Despeckle removes noise by detecting the edges in an image and 
blurring all of the selection except those edges.

To reduce the redeye effect (Truecolor image types):
1. On the Filter menu, click Redeye Reduction.
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In the Redeye Reduction dialog box, the original image appears on 
the left. As you modify the image, you can see the results on the right.

2. Click Zoom In to zoom in on the eyes.

3. After zooming, if the eyes do not appear in the After box, click Scroll. 
On the image in the After box, drag the mouse pointer to locate the 
eyes. 

4. Click Select. On the image in the After box, drag the mouse pointer to 
outline the eyes.

5. Click the appropriate eye color.

6. Move the slider to the right to increase the colored area, to the left to 
decrease. Or, specify a value in the Amount box.

When you use the redeye reduction feature, you reduce the redness of the 
eyes that appears on some images.

To make your image sepia-toned (not available with Black and White 
or 2 Color image types):
On the toolbar or Effects menu, click Sepia.
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Applying the Sepia effect gives your image an antique look. When you 
apply this effect, the colors in your image are converted to shades of 
reddish brown.

To colorize your image (not available with Black and White or 2 Color 
image types):
1. On the toolbar or Effects menu, click Colorize.

The original image appears on top in the Colorize dialog box. As you 
modify the image, you can see the results on the bottom.

2. Move the slider up to increase the hue or saturation values, down to 
reduce. Or, specify a value in the appropriate box.

Applying the Colorize effect converts your image to a monochrome. The 
image can then be adjusted by defining the hue and saturation values.

To convert your image into a negative (not available with High Color 
image types):
On the toolbar or Effects menu, click Negative.

Applying the Negative effect inverts the image. When you apply this 
effect, the colors in your image are converted to black and white.
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Chapter 7
Fine-tuning the MultiPASS Suite 7

To successfully operate your MultiPASS system, you need to be familiar 
with defining device and system settings, using the Status Monitor, and 
disconnecting the printer or removing the software.

Defining Device Fax Settings (F50) 6

Although you can set fax options directly in the printer itself, you can also 
define the settings on your PC. You define settings that affect general 
preferences for sending and receiving a fax and speed dial assignments.

To define general fax preferences:
In My MultiPASS, on the MultiPASS menu, point to Device Setup/Speed 
Dial, and then click MultiPASS F50. On the Preferences tab, define the 
following settings:
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❏ Date Format
Click the format you want to use to display the date on the printer 
LCD and for printing the date on a fax.

❏ Display Language
Click the language you want to use on the printer LCD.

❏ Volume
Click the volume level of the various sound components of your 
printer to best suit your office environment.

❏ Paper Type
Click the type of paper on which you want to print faxes.

❏ Bottom Margin
Click whether to print a normal or longer than normal bottom 
margin. This option is useful when receiving faxes, printing, or 
copying in color.

❏ Print Activity Report Automatically
Click to have the printer automatically print an activity report after 
every 20 faxes sent and received. If this option is cleared, an activity 
report is not printed.
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To define send fax settings:
In My MultiPASS, on the MultiPASS menu, point to Device Setup/Speed 
Dial, and then click MultiPASS F50. On the Send Fax tab, define the 
following settings:

❏ Fax Information
Specify the following information to appear as the header for all 
faxes: your name and your fax number.

❏ Phone Line
Click the dialing method the printer uses: touch tone or rotary pulse.

❏ Automatic Retries
Specify the number of retries the system should attempt when 
sending a fax transmission, and the length of time between each retry.

❏ Automatic Report
Click whether or not you want a report to print with each fax 
transmission, only when there is an error, or no report.

Also, click if you want an image of the first page of the fax included in 
the report (not available with PC faxing). 
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To define advanced send fax options:
On the Send Fax tab, click Advanced. In the Advanced Send Fax dialog 
box, define the following settings:

❏ Speed
Click the transmission speed to want to use to send faxes. The higher 
the setting, the faster the transmission. If you experience problems 
when sending faxes, try a lower speed setting.

❏ Pause Duration
Click the length of the pause that you may have to insert when 
dialing a long distance number.

❏ Error Correction (ECM)
Click to reduce system and line errors when sending a fax. With this 
option selected, the system checks each outgoing fax for lost data. If 
data has been lost from a portion of a page, the system transmits that 
portion again after confirming that all data within that portion can be 
transmitted successfully.

❏ Auto Start Send
Click if you want the unit to start scanning automatically if a speed 
dial number is pressed.

❏ Off Hook Alarm
Click to turn on the alarm after the printer has received or sent a fax if 
the telephone is off-hook.
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❏ Color Direct Send
Click to have a color fax printed in black and white if the receiving fax 
machine cannot receive a color fax.

❏ Position
Click where you want the sent fax heading information (your fax 
number, your name, and date and time) to print on the faxes you 
send. This information is known as the Transmit Terminal 
Identification (TTI).

❏ Mark Faxes With
Click how you would like to identify the fax/phone number in the 
header of a fax you send. For example, if you typically use the 
designated number for phone calls rather than sending faxes, you can 
identify the number as a telephone number. Otherwise, identify the 
number as a fax number, used primarily for sending and receiving 
faxes.

To define receive fax options:
In My MultiPASS, on the MultiPASS menu, point to Device Setup/Speed 
Dial, and then click MultiPASS F50. On the Receive Fax tab, define the 
following settings:
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❏ Paper Size
Click the size of the paper you are using for printing a fax, based on 
the source of the paper. 

❏ Reduce to Fit Paper
You can specify whether you want an incoming fax reduced to ensure 
the contents fits on the paper on which it is printed. If you want to 
reduce the incoming fax, you can fit to height only, or both the height 
and width, to fit the paper size.

❏ Answer Receive Mode
Click the mode by which you want the printer to receive incoming 
calls:

• Automatically switch for receiving a call either as a fax or 
telephone call

• Automatically receive only fax calls

• Require you to manually answer the incoming call, and then set 
the printer for an incoming fax

• Automatically receive a call with your answering machine

• Automatically switch between receiving a call either as a fax or 
telephone call based on the ring tone for each type of call. (U.S. 
only. This setting is applicable only if you subscribe to a special 
network service with your phone company that defines multiple 
ring tones for your phone line.)

❏ Answer Silent Receive
Click to set the printer not to ring for an incoming fax.

❏ Answer Number of Rings
If you cleared the Silent Receive option, indicating you want the 
printer to ring for incoming fax calls, click the number of times the 
printer should ring for the fax call. The printer only rings if you have 
connected an extension telephone.
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❏ Receive Conditions
Click how the system should handle an incoming fax under the 
following conditions:

• If your computer is turned off or the Status Monitor is not 
running:
Click to set the printer to print the fax or save the fax in its 
memory.

• If your computer is turned on and the Status Monitor is running:
Click to set the printer to move the fax to your computer, or to 
print the fax.

❏ Report Print
Click whether or not you want a report to print with each fax 
reception, or only when there is an error.

To define advanced receive fax settings:
On the Receive Fax tab, click Advanced. In the Advanced Receive Fax 
dialog box, define the following settings:
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❏ Speed
Click the transmission speed used to receive faxes. The higher the 
setting, the faster the fax is received. If you experience problems 
when receiving faxes, try a lower speed setting.

❏ Error Correction (ECM)
Click to reduce system and line errors when receiving a fax. With this 
option selected, the system checks each incoming fax for lost data. If 
data has been lost from a portion of a page, the system receives that 
portion again after confirming that all data within that portion can be 
received successfully.

❏ Listen Time Before Ringing
When a call is received, the printer checks to see if the call is from a 
fax machine or a telephone. If the printer does not have enough time 
to detect the fax tone, it assumes the call is from a telephone. Click to 
set the appropriate amount of time to allow the printer to check for 
the type of call.

❏ Ring Time
When your printer is set to receive both fax and telephone calls, it 
rings to inform you of an incoming telephone call. If you do not pick 
up the telephone receiver within a certain amount of time, the printer 
stops ringing. Click to set the appropriate amount of time the printer 
should ring.

❏ Ring Tone
Click to set the volume level of the ring tone.

❏ Default Action If No Answer to Telephone
Click Receive if you want the printer to handle an incoming call, 
detected as a telephone call that is not answered, as an incoming fax. 
If no fax is received, the line is then disconnected. If you set this 
option to Disconnect, the printer automatically disconnects the 
unanswered call, without switching to try and receive a fax.

❏ Manual/Auto Switch
To prevent missing incoming documents when the printer is set to 
manual receiving, click to set the unit to automatically answer the 
phone and switch to automatic. The unit can receive the incoming fax 
after the specified ring time (the number of seconds you specify).
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❏ Remote Receive
Click so that you can set the printer, from a telephone extension, to 
receive a fax if an incoming call is ringing on the printer. If you select 
this option, you must assign a remote identification number that 
signals the printer to receive the fax.

❏ Remote Identification Number
If the Remote Receive option is selected, enter the identification 
number you will use to set the printer to receive a fax.

❏ DRPD Switch Option
If you subscribe to the Distinctive Ring Pattern Detection (DRPD) 
service through your phone company click the desired ring pattern.

Setting Up Speed Dial Assignments 6

You can set up fax numbers for speed dialing with the printer. You use 
the fax recipients set up in your address book, assigning the desired 
individual to speed dial codes.You can also set up a group speed dial, by 
assigning two or more individual speed dial assignments to a single 
speed dial assignment. For reference, you can print the list of speed dial 
assignments to display near the printer.

To assign a fax recipient to a speed dial code:
1. In My MultiPASS, on the MultiPASS menu, point to Device Setup/

Speed Dial, and then click MultiPASS F50. 

2. On the Speed Dial tab, in the Address Book box, click Address Book 
to display the contents.
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3. In the Address Book list, click the recipient that you want to assign to 
a speed dial code.

4. On the Speed Dial list, click the speed dial number to which you want 
to assign the recipient, and click Add.

5. To remove a recipient from a speed dial number, in the Speed Dial 
list, click the speed dial number, and then click Remove.

To print the speed dial assignment list:
Click Print List.

To define a group speed dial:
1. On the Speed Dial tab, make sure the desired recipients for your 

group are set up as individual speed dial assignments.

2. Click the speed dial number to which you want to assign the group of 
recipients, and click Group Dial.
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3. In the Group Dial dialog box, in the Group Name box, enter a name 
for the group.

4. In the Speed Dial list, click the first recipient and click Add. Repeat 
this procedure until the desired recipients are included in the 
Members list. 

5. To remove a member from the group, click the member in the 
Members list and click Remove.

Defining System Settings (F50) 6

You can define general settings that affect the operation of the MultiPASS 
Suite.

To define general system preferences:
In My MultiPASS, on the MultiPASS menu, click Options. In the Options 
dialog box, define the following settings:
Chapter 7 Fine-tuning the MultiPASS Suite   129



manual.book  Page 130  Wednesday, August 22, 2001  3:44 PM
❏ Click at what point entries in the Fax Log should be automatically 
removed.

❏ Click to restore showing any dialog boxes where “Don’t show this 
again” had been clicked previously.

❏ Click the MultiPASS printer model that you want to use as the default 
fax device.

❏ Click whether you want a warning message to appear when a fax 
transmission fails.

❏ Click whether you want a message to appear when a new fax is 
received.

Using the MultiPASS Status Monitor 6

You use the Status Monitor to review the current status of the printer and 
any error conditions needing your attention. You cannot interrupt 
MultiPASS activity with the Status Monitor.

When the Status Monitor is open, it displays as a window on the 
Windows desktop or an icon in the Windows taskbar.
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Although you can close the Status Monitor, it is recommended that you 
keep the Status Monitor open while your computer is on and the printer 
is connected. The Status Monitor must be open for you (and any shared 
users) to use your printer with your computer.

To open the Status Monitor, if currently closed:
On the Windows desktop, click Start, point to Programs, point to 
MultiPASS Suite, and then click MultiPASS Status Monitor.

To display the Status Monitor menu:
Right-click the Status Monitor window or icon.

To display the Status Monitor window:
If the Status Monitor appears only as an icon on the taskbar, click Restore 
on the Status Monitor menu.

To specify the Status Monitor window as the top window:
Click Always On Top on the Status Monitor menu.

To reconnect communication between the printer and MultiPASS Suite 
(parallel port connection only):
As needed, if you previously disconnected the printer from its port, click 
Reconnect on the Status Monitor menu.

To display the port on which the printer is connected:
Click Device Information on the Status Monitor menu.

To minimize the Status Monitor window:
If the Status Monitor window currently appears, and you prefer to 
display only the icon on the taskbar, click Minimize on the Status Monitor 
menu or click the Minimize button on the title bar.

To set the Status Monitor to open when you start Windows:
Click Load on Windows Startup on the Status Monitor menu.

Status Monitor
window 
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To close the Status Monitor:
As needed (for example, if you are removing the MultiPASS Suite 
software), click Close on the Status Monitor menu.

Restarting the Printer and MultiPASS Connection 6

If you reconnect the printer to the port and want to begin using the 
MultiPASS Suite again, the connection between your printer and 
MultiPASS system automatically restarts when you restart your 
computer. You can also restart the MultiPASS connection without 
restarting your computer.

To restart the MultiPASS connection without restarting your computer:
1. If you are using Windows NT/2000, restart MP Service (MultiPASS 

Service). For details, see your Windows NT/2000 documentation.

If you are using Windows 95/98/Me, skip to Step 2.

2. Reconnect the communication between printer and the MultiPASS 
Suite by opening the Status Monitor.

If already open, the Status Monitor should automatically reconnect 
communication between the MultiPASS Suite and your printer. 
However, if the Status Monitor does not automatically reconnect, 
display the Status Monitor menu and click Reconnect.

Removing the MultiPASS Suite 6

If you are planning on reinstalling the MultiPASS Suite, you must first 
remove the current installation of the software. 

If you are using Windows NT/2000, you must log on as Administrator or 
have Administrator privileges to remove the MultiPASS Suite software.

When you remove the MultiPASS Suite, all the software components 
(such as the printer and fax drivers) are automatically removed. 
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To remove the MultiPASS Suite:
1. Close the MultiPASS Suite and all of its components, including the 

Toolbar and Status Monitor. 

Be sure to close, and not just minimize, the Toolbar and Status 
Monitor. To close the Toolbar, right-click the Toolbar icon on the 
Windows taskbar, and then click Exit MultiPASS Toolbar on the 
Toolbar menu.

2. On the Windows desktop, click Start, point to Settings, and then click 
Control Panel.

3. In Control Panel, double-click Add/Remove Programs.

4. In the Add/Remove Programs Properties dialog box, click 
MultiPASS Suite, and then click the Add/Remove button (Windows 
95/98/Me/NT) or the Change/Remove button (Windows 2000).

5. Follow the on-screen instructions.

When prompted, click Remove to remove the MultiPASS Suite.

6. If prompted when the removal process is complete, restart your PC.

If your installation of the MultiPASS Suite becomes damaged at some 
point (for example, program files are accidently deleted from the system), 
you can repair your installation without having to remove and reinstall 
the software. To do so, follow the instructions for removing the 
MultiPASS Suite. However, when prompted, click Repair instead of 
Remove. Then, follow the on-screen instructions. You may need to have 
your MultiPASS Suite installation disk available during the repair 
process.

Reinstalling the MultiPASS Suite 6

After you have uninstalled the MultiPASS Suite, you use the same 
instructions for reinstalling as described in Chapter 2, “Installing the 
MultiPASS Suite.” 
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Changing the Port Connection 6

If you are using Windows 98/Me or Windows 2000, and have a USB port 
available on your computer, you may want to change the port to which 
you originally connected, either between the parallel port and USB port; 
or from one USB port to another USB port, or USB port with a hub.

To change ports between parallel and USB:
1. Remove the MultiPASS Suite software. 

For details, see the “Removing the MultiPASS Suite” section in this 
chapter.

2. Disconnect the printer from the port on your computer.

3. Reinstall the MultiPASS Suite software. 

For details, see the “Installing the MultiPASS Suite” section in 
Chapter 2.

To change ports between USB ports, or a USB port with a hub:
Simply disconnect the printer cable from the USB port on your computer 
and, when ready, reconnect to the other USB port or hub. 

When changing the port connection, it is not necessary to remove and 
reinstall the MultiPASS Suite software. 
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Chapter 8
Frequently Asked Questions 8

To assist you in the operation of the MultiPASS Suite, see the solutions for 
some commonly asked questions.

Printer Cannot Be Initialized. 10

❏ Is the operation panel blank?

You might have a power problem. Check that the power cord is plugged 
securely into the printer, that the printer is on, and that your electrical 
source is OK. You should have the printer connected directly to its own 
AC outlet and not connected to a power strip to which your computer is 
connected. 

❏ Is the printer set to the correct port?

Parallel port only: Make sure that the printer is configured for the correct 
port in the Printer Properties dialog box. Be sure that it is the only device 
configured to a particular port. Remove any switch boxes, zip drives, tape 
backups, docking stations, or scanners from the port if necessary. Check 
both ends of the printer cable to be sure that it is securely fastened.

❏ Is the printer connected to the computer using the USB port?

❏ You might have disconnected the MultiPASS printer from the USB 
port while the MultiPASS Suite was still running. Reconnect the 
printer to the USB port.

❏ You might have connected a printer other than the MultiPASS printer 
to the USB port assigned to the MultiPASS printer while the 
MultiPASS Suite was still running. Reconnect the MultiPASS printer 
to the USB port.
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❏ Your USB cable may be too long or defective. Check to make sure that 
the USB cable complies with the MultiPASS hardware requirements. 

❏ Is the printer connected to the computer using a parallel port?

❏ You might have disconnected the MultiPASS printer from the parallel 
port while the MultiPASS Suite was still running. Reconnect the 
printer to the parallel port, and then click Reconnect on the Status 
Monitor menu.

❏ You might have connected a printer other than the MultiPASS printer 
to the parallel port assigned to the MultiPASS printer while the 
MultiPASS Suite was still running. Reconnect the MultiPASS printer 
to the parallel port, and then click Reconnect on the Status Monitor 
menu.

❏ Your parallel printer cable may not be compatible with the printer. 
Check to make sure your cable complies with the MultiPASS 
hardware requirements.

❏ The printer may be attached to the wrong parallel port. Try changing 
the port assignment in the printer properties.

❏ A pass-through device, such as a ZIP drive, may be connected to the 
same parallel port as the printer. Try disconnecting the pass-through 
device. Then, reconnect the printer directly to the parallel port. 

❏ Another running program is using the same parallel port as the 
printer. Verify that all other printer software applications using the 
parallel port are closed. In addition, if you have multiple printers, 
assign the other printers to a different parallel port than the port used 
by the MultiPASS printer.
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Installation Is Displaying Unexpected 
Behavior. 10

❏ For Windows 98 with parallel port connection: When restarting after 
installation, is the system trying to install the printer driver again?

When you restart the computer after installing the MultiPASS Suite, you 
may encounter one of the following situations:

❏ Found new hardware wizard displays.
If this occurs, click Cancel.

❏ Prompt for MultiPASS Suite Installation Disk displays.
If this dialog box displays, do one of the following:

• If Cancel is available, click Cancel.

• If Cancel is not available, click OK. Then insert the MultiPASS 
Suite disk into your disk drive and browse to the following 
folder:

MultiPASS\PrnDrv\F50\WinBj\disk1

❏ For Windows 2000 with USB port connection: Are you not able to 
complete the installation of the MultiPASS Suite?

During the installation, you may be unable to continue beyond the dialog 
box prompting you to connect your printer cable to your port.

In this situation, you need to exit the MultiPASS Suite setup, remove the 
device from the Windows Device Manager, and restart the installation 
process.

To resolve this situation:
1. Click No in the dialog box prompting you to connect your cable, and 

exit the MultiPASS Suite setup.

2. Remove the device from the Windows Device Manager. The device 
may appear listed as Canon MultiPASS or Unknown Device.
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To remove the device: Click Start, point to Settings and then click 
Control Panel. In the Control Panel window, double-click System. On 
the Hardware tab, click Device Manager. Under Other Devices, click 
the device and press the Delete key.

If you are unable to remove the device, turn the printer off, and then 
on again.

3. Disconnect your printer cable from the port.

4. Start the MultiPASS Suite installation process again. For instructions, 
see Chapter 2, “Installing the MultiPASS Suite.”

❏ For Windows 98/Me with USB port connection: Are you not able to 
complete the installation of the MultiPASS Suite?

During the installation, you may be unable to continue beyond the dialog 
box prompting you to connect your printer cable to your port. You cannot 
continue the installation of the MultiPASS Suite.

In this situation, you need to exit the MultiPASS Suite setup, remove the 
device from the Windows Device Manager, and restart the installation 
process.

To resolve this situation:
1. Click No in the dialog box prompting you to connect your cable, and 

exit the MultiPASS Suite setup.

2. Remove the device from the Windows Device Manager. The device 
may appear listed as Canon MultiPASS or Unknown Device.

To remove the device: Click Start, point to Settings and then click 
Control Panel. In the Control Panel window, double-click System. On 
Device Manager tab, under Other Devices, click the device and press 
the Delete key.

If you are unable to remove the device, turn the printer off, and then 
on again.

3. Disconnect your printer cable from the port.
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4. Start the MultiPASS Suite installation process again. For instructions, 
see Chapter 2, “Installing the MultiPASS Suite.”

❏ Are you not able to complete the installation or removal of the 
MultiPASS Suite?

If installation stops unexpectedly, or you cannot complete uninstallation, 
you may need to force the setup program to run. 

To resolve this situation:
1. On the Windows desktop, click Start, and then click Run.

2. In the Run dialog box, type the following command (where D: is your 
disk drive), and then click OK:

D:MultiPASS\Setup\Setup.exe --Force

3. Start the MultiPASS Suite installation process again. For instructions, 
see Chapter 2, “Installing the MultiPASS Suite.”

Images Are Not Scanning Properly. 10

❏ Are you having problems scanning an image with your TWAIN-
compliant Windows application?

If you installed the TWAIN-compliant Windows application after 
installing the Multipass Suite, there may be a problem with the TWAIN 
system files that were overwritten. To correct the problem, reinstall the 
MultiPASS Suite software.

❏ Is scanning an image very slow?

If you change the parallel port on your computer to ECP (Extended 
Capabilities Port), scanning speed and throughput increase.

For details on using ECP, refer to your user documentation or contact 
technical support for your computer.
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❏ Is the scanned image blank?

❏ Check that the image source is placed correctly on the platen or in the 
automatic document feeder (F50). 

❏ Check to see if you specified the desired feed location (platen or 
automatic document feeder) in the MultiPASS Toolbar settings.

❏ Does a white border appear on the left hand side of the image?

Set the document approximately 3 millimeters away from the edge of the 
platen glass.

Documents Are Not Printing Correctly. 10

❏ Is the operation panel blank?

You might have a power problem. Check that the power cord is plugged 
securely into the printer, that the printer is on, and that your electrical 
source is OK.

❏ Is the printer warm to the touch?

The printer might have overheated and shut down. Turn the printer off 
and let it cool down for 15 minutes. Try using it again. 

❏ Is the ALARM light on?

❏ Check the LCD display for a message. If a message is displayed, take 
the appropriate action to correct the error and clear the message. 
Press Resume to continue.

❏ Turn off and unplug the printer. Wait 15 seconds and plug it in again 
and turn it on. The ALARM light should go out.
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❏ Does paper not come out of the printer?

Parallel port only: Check that you have a bi-directional parallel cable 
connecting the printer to your PC. Check your computer’s setup to be 
sure the primary parallel port is set to the appropriate printer port, for 
example, LPT1 or LPT2. Make sure the Print Setup option of your 
printing application displays that the correct printer is being used.

❏ Is the printing not fast enough?

The print options you have selected might be too complex. Set print 
options to the basics, such as standard quality, automatic print mode, and 
so on. 

❏ Does the job not print when using DOS?

The printer driver can be used to print documents only in Windows; it 
cannot print a document in DOS.

❏ Are you unable to print?

❏ Your Windows application settings may be preventing you from 
printing successfully. Check the settings of the Windows application 
you are trying to print from.

❏ The printer driver may not be configured correctly. Try printing a test 
page with your printer driver. If the test page prints successfully, the 
printer and printer driver are set up appropriately. If the test page 
does not print successfully, you need to remove and reinstall the 
MultiPASS Suite.

❏ Are you unable to print to a shared printer?

If you are using a client system that is set up to use a shared printer, yet 
you are unable to print to the shared printer, check the following:

❏ That the server system, to which the printer is connected, is turned on

❏ That the server system has set the printer to be shared

❏ That the server system is set to allow your system access to the shared 
printer.
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❏ Is the document printing with undesirable results?

For a parallel port connection only: You may experience undesirable 
results when printing a document if you have the Windows Printing 
System (or other bi-directional device, such as a later model laser printer) 
installed on your computer and you are attempting to use the same 
parallel port to which you also have the printer connected. Be sure that 
the printer is the only device configured to a particular port. The printer 
operates properly only with a dedicated, parallel port.

❏ Are you unable to print documents in the background (Windows 95/
98/Me)?

❏ Check the amount of available disk space on your computer. 
Background printing requires a certain amount of available disk 
space. If enough space is not available, you may need to delete 
unnecessary files or disable background printing.

❏ Check to see if background printing in the Printer Control setting of 
the printer driver is enabled. 

❏ Does a Printer Port error message appear?

❏ Check to see if the printer is turned on. If nothing is displayed in the 
LCD, turn the printer on. If the Alarm lamp is flashing red, the printer 
is initializing. Wait until the Alarm lamp stops flashing before trying 
to print.

❏ Check to see if spooling is enabled. If spooling is enabled, disable it 
and try printing again.

To disable printer spooling:
1. In the Printer Properties dialog box, do one of the following

• For Windows 95/98/Me: Click the Details tab, and then click 
Spool Settings.

• For Windows NT: Click the Scheduling tab.

• For Windows 2000: Click the Advanced tab.
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2. Click Print Directly to the Printer. 

❏ Does an application error or General Protection Fault error appear?

❏ Check to see if the application you are using is compatible with the 
operating system you are using.

❏ If other applications are open, close them to increase the available 
memory. Try printing it again.

❏ Check to see if enough memory is allocated to the application. For 
application memory guidelines, see documentation for your 
application.

❏ If the problem only occurs when printing a specific document, try 
opening and editing the document. Try printing it again.

Paper Is Not Loading Correctly. 10

❏ Does paper not load into the unit?

The multi-purpose tray might contain too many sheets or paper might not 
be inserted all the way into the multi-purpose tray. 

❏ Does paper not feed through one sheet at a time?

Be sure to fan the stack of paper before placing it in the multi-purpose 
tray. Make sure the stack of paper does not exceed the paper limit mark.

❏ Does paper not feed through the automatic document feeder?

If paper jams in the automatic document feeder, on the printer, press 
Resume to continue feeding the jammed paper until it is removed from 
the printer. If pressing Resume does not work, open the feeder cover and 
remove the document gently; then close the feeder cover. 

❏ Is an envelope not loading correctly?

❏ Make sure you do not stack more than 10 envelopes in the multi-
purpose tray.
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❏ Perform roller cleaning. For more information about cleaning the 
rollers, see the Online Reference Guide.

The Print Quality Is Not Satisfactory. 10

❏ Are some of the characters not printing?

If characters are not printing, check that the printer cable is securely 
plugged in at both ends. Make sure your cable does not exceed the 
maximum length: 6.6’ (2m) for a parallel cable, 16.4’ (5m) for a USB cable.  
Check your application’s print setup to make sure the printer is selected.

❏ Do characters not fit on the page?

Make sure paper is aligned correctly in the multi-purpose tray. Check 
that margins and paper size are set correctly in your printing application. 

❏ Is printing not clear?

Check to see if you are printing using the Draft print quality option.

❏ Do fonts not print smoothly?

Bitmapped fonts designed for dot matrix printers will not look smooth 
when printed by high-resolution printers such as the Canon printer. 
Choose another font. Make sure you install an outline font manager such 
as Adobe Type Manager or Bitstream Facelift, or that you choose a 
TrueType font.

❏ Is the printing not dark enough?

You might be using Draft print quality. Try setting print quality to 
Standard. Try replacing the ink cartridge.

❏ Are pages printing blank?

❏ You may be running out of ink. Try replacing the ink tank.

❏ The print head may be dirty. Try performing a nozzle check to see if 
the print head needs to be cleaned. For more information, see the 
Reference Guide.
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❏ Are the colors unclear?

❏ Check to see if the Media Type setting in the printer driver matches 
the type of paper loaded in the printer. 

❏ If you are printing a photograph or illustration, try increasing the 
Print Quality setting in the printer driver.

❏ Check to see if the correct ink tanks are installed. If installed, check to 
see if the ink tanks are empty and need to be replaced.

❏ Printed colors do not always match the colors on your screen exactly. 
If you are unhappy with the colors printed appearance, try changing 
the colors in your document. 

❏ Are colors uneven or streaked?

❏ Try setting the halftoning method to Diffusion in the printer driver.

❏ Try removing the print head, reinstalling it, and then aligning it. For 
more information, see the Quick Start Guide.

❏ Are the wrong colors printing or are the colors blurry when printed?

❏ If a specific color is not printing, check to see if the corresponding ink 
tank is empty and needs to be replaced.

❏ Certain media can only be printed on one side, such as photo paper. 
Check to see if you are printing on the correct side of the media.

❏ Are the lines in the document skewed?

❏ Make sure paper is aligned correctly in the paper tray.

❏ Try increasing the Print Quality setting in the printer driver.

❏ Try removing the print head, reinstalling it, and then aligning it. For 
more information, see the Quick Start Guide.
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❏ Are stray marks appearing on your printed documents?

❏ In your application, check that the margins of the document are 
within the recommended printing area. 

❏ Try reducing the Intensity setting in the printer driver. 

❏ Does your printed document curl?

Too much ink on plain paper can cause the paper to curl. Try using photo 
paper or high resolution paper to print images that require a lot of ink, 
such as pictures or photographs.

❏ Are meaningless characters or symbols appearing on your printed 
document?

If the problem only occurs when printing a specific document, try 
opening and editing the document. Then print it again.

If the problem occurs with all documents originated from a specific 
software application, there may be a problem with the software 
application.

❏ Does the printer stop printing before it has reached the end of the 
document?

Check to see if the Page Size setting in the printer driver matches the size 
of the paper loaded in the printer. In addition, check for a matching page 
size setting in the software application where your document was 
originated.
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Appendix A  
Fax/Phone Characters A

Whenever entering or setting up a fax or phone number in the MultiPASS 
Suite—when sending a PC fax, setting up an entry in the Address Book, 
or making a phone call—you use only the following characters. 

Character Description

0 to 9 * # Dialing digits

, p Pause

P Last Pause

T Tone switch over function

. DT detection function
(Europe)

R PSTN/PBX switchover function
(Europe)

+ - ( ) Space Display-only characters. Space cannot be 
used at the beginning of a number. 
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Appendix B  
Sharing Your Printer Cross-Platform in 
Windows NT/2000 B

If you are using Windows NT/2000, you may need to set up an alternate 
or additional driver in the following situations:

❏ Windows NT/2000 server system sharing with Windows 95/98/Me 
client systems

❏ Windows 2000 server system sharing with Windows NT client 
systems.

The procedures vary somewhat based on whether you are using 
Windows NT or Windows 2000. For the setup procedure, have the 
MultiPASS Suite installation disk available.

To share your printer in Windows NT:
1. On the MultiPASS server system, on the Windows taskbar, click Start, 

point to Settings, and then click Printers.

2. In the Printers window, click the printer icon.

3. On the File menu, click Sharing.

4. In the Properties dialog box, on the Sharing tab, click Shared. 

5. In Share Name box, type a name you want to assign to the shared 
printer.

6. Under Alternate Drivers, click Windows 95. Then, click OK.

7. Follow the on-screen instructions.

• When prompted to insert the Windows 95 Flat Share disk into 
your disk drive, insert the MultiPASS Suite installation disk 
instead.
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• When prompted for an .inf file, browse the MultiPASS Suite 
installation disk for the following folder:

MultiPASS\PrnDrv\F50\WinBj\disk1

To share your printer in Windows 2000:
1. On the MultiPASS server system, on the Windows taskbar, click Start, 

point to Settings, and then click Printers.

2. In the Printers window, click the printer icon.

3. On the File menu, click Sharing.

4. In the Properties dialog box, on the Sharing tab, click Shared As. 

5. In the Shared As box, type a name you want to assign to the shared 
printer.

6. Click Additional Drivers.

7. Follow the on-screen instructions:

• When prompted in the Additional Drivers dialog box, click the 
environment you want to support on your Intel Pentium system: 
Windows 95/98, or Windows NT 4.0. 

• When prompted to insert your Windows 2000 disk into your disk 
drive, insert the MultiPASS Suite installation disk instead.

• When prompted for an .inf file, browse your MultiPASS Suite 
installation disk for the following folder:

For setting up the Windows 95/98/Me driver:
MultiPASS\PrnDrv\F50\WinBj\disk1

For setting up the Windows NT driver:
MultiPASS\PrnDrv\F50\NTDrv\disk1
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Glossary G

A

application
Software prepared for a specific function or set of functions. Examples of 
an application program include word processing programs and the 
MultiPASS Viewer. Developers who make application programs include 
drivers that support different types of printers.

ASCII
Acronym for American Standard Code for Information Interchange. A set 
of definitions for the bit composition of characters and symbols. ASCII 
defines 128 symbols using 7 binary bits and 1 parity bit. 

automatic feed
Method by which paper can be fed into the printer when the built-in 
paper feeder is used. 

B

bi-directional parallel interface port
An interface connection that is capable of both sending and receiving 
information. For example, when you print or send a PC fax from your 
computer, information is sent from your computer to the printer. When 
you scan or receive a fax into your computer, information is sent from the 
printer to your computer.

D

default setting
A system setting incorporated at the factory and permanently registered 
application. Also, a value or a setting that the software assumes until or 
unless you specify another value. 

dpi
Dots per inch. A unit of measurement for indicating a printer’s resolution. 
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G

gamma
Contrast displayed within the middle of the tonal range (midtones) of 
your image.

graphic
A written, printed, or electronically displayed symbol or drawing. Also, 
characters or text that have been generated by a computer graphics 
application program. 

grayscale
A color in black and white as a result of different intensities of black. 

H

halftone
A bilevel (single bit) image composed of dots, lines, or another pattern, 
that mimics the appearance of a black and white image.

L

landscape orientation
The horizontal orientation of your document or image across the length 
of the page. The term landscape is derived from pictures of the landscape, 
which are usually horizontal in format. 

M

MAPI
Acronym for Messaging Application Program Interface.

metadata
Data about data. Metadata describes how, when, and by whom a 
particular set of data was collected, and how the data is formatted. For 
example, the title, subject, author, and size of a document or image file 
constitute metadata about the file.

midtone
The middle of the tonal range of your image.

P

paper feed
Movement of a sheet of paper into the printer’s paper path. 
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PC fax
An electronic way to send and receive faxes from your computer. A PC 
fax is sent from or received in a computer. Using the printer you can send 
and receive PC faxes and the MultiPASS Suite lets you save, sort, and 
print the PC faxes. 

portrait orientation
The vertical orientation of your document or image across the width of 
the page (letter style). This is the opposite of landscape orientation. 

printer driver
Software that sends printing instructions to a printer. The printer driver 
keeps track of the attributes of a printer and the codes a program must 
send to access those attributes. 

T

threshold
In a bilevel (single bit) image, the point at which a gray pixel is 
determined to become black or white.

TWAIN
Both a protocol and an application programmer’s interface (API) that 
allows you to input image data directly from any source (for example: 
desktop and handheld scanners, video capture boards, digital cameras, 
and other imaging equipment) without requiring you to switch out of the 
application. It provides compatibility between image input devices and 
applications by acting as the liaison between hardware devices and 
software applications. Because your printer supports TWAIN, you can 
use the scanning features of the printer with any Windows application 
that supports TWAIN. Twain, the industry standard, was developed by 
the TWAIN working group which consists of representatives from many 
leaders in the scanner hardware and software industry. 

U

USB
Universal Serial Bus (USB) is a connectivity specification for attaching 
peripherals to computers. It eliminates the need to install cards into 
dedicated computer slots and reconfigure the system.
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W

WAB
Acronym for Windows Address Book. The associated file is named with 
the .wab file extension.
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Index I

A
activity report

setting up a fax preference 120
Address Book

adding a contact entry 65

adding a distribution list entry 66

adding a fax recipient 51

creating for MultiPASS 63

deleting an entry 70

editing a distribution list entry 69

editing contact information 66

opening 64

replacing the default address book 70

searching for an entry 70

setting up 63
specifying a different Windows Address 

Book file 70

specifying a fax recipient 50

types, described 63
advanced mode

scanning a preview image 78
answer receive mode

setting for receiving faxes 124
application

setting a scan preference on the Toolbar 90
apply throughout page

setting print effects 44
auto start send

setting for sending faxes 122
automatic retries

setting for sending faxes 121

B
background

deleting from printing (Win95/98/Me/2000) 
42

saving for printing (Win95/98/Me/2000) 42
selecting and defining for printing (Win95/

98/Me/2000) 40

using when printing (Win95/98/Me/2000) 
31

background printing
setting 30

banner
printing 29

black and white
adjusting tone when scanning 87

blur
an image in the Photo Enhancer 114

bottom margin
setting fax preference 120

brightness
adjusting tone when scanning 83

button size
setting a Toolbar preference 93

C
cable

system requirement 2
change

port connection 134
close

the Photo Enhancer 96

the Toolbar 93
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Viewer 96
collate

setting for printing 27
color adjustment

setting for printing 22

setting manually for printing 24
color balance

adjusting in the Photo Enhancer 112
color level

automatically adjusting in the Photo 
Enhancer 113

manually adjusting in the Photo Enhancer 
113

ColorGear Color Matching
setting when scanning 79

colorize
images in the Photo Enhancer 117

computer processor
system requirement 2

contact
adding to the Address Book 65

editing information 66
contrast

adjusting tone when scanning 83
copies

setting for printing 26
cover sheet

attaching for your PC fax 52

previewing 53

printing 53
crop

images in the Photo Enhancer 111
cropped image

when scanning 81
cross-platform

sharing the printer with Windows NT/2000, 
overview 149

custom image type
defining for scanning in simple mode 77

custom paper size
setting for printing 27

custom print quality
setting 22

D
date format

setting up a fax preference 120
default fax device

setting 130
default print settings

defining 46
default printer

setting 12
descreen

when scanning 81
despeckle

image in the Photo Enhancer 115
device fax settings

defining 119
device information

displaying with the Status Monitor 131
disk drive

system requirement 2
display

document in the Viewer 95, 98

image in the Photo Enhancer 96

saving the display in the Viewer 97

specifying preferences 96
display language

setting up a fax preference 120
distribution list

adding to the Address Book 66

editing an entry 69
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document
displaying in the Viewer 95
paging through in the Viewer or Photo 

Enhancer 96

printing in the Viewer 98

printing thumbnails in the Viewer 99

setting as wallpaper 108
DRPD switch option

setting for receiving faxes 127

E
ECM

setting for receiving faxes 126

setting for sending faxes 122
effects

setting 43
e-mail

specifying for a fax 49
Enable ICM

setting for printing 24

F
failed fax transmission

setting a warning message 130
fax

automatically forwarding 59

receiving 58
fax activity report

setting up a fax preference 120
fax address book

setting up 63
fax device

setting default 130
fax error correction

setting for receiving faxes 126

setting for sending faxes 122

fax heading position
setting for sending faxes 123

fax information
setting for sending faxes 121

Fax Log
clearing entries 130

using 62
fax mark

setting for sending faxes 123
fax number

specifying for a fax 48
fax paper fit

setting for receiving faxes 124
fax paper size

setting for receiving faxes 124
fax receive conditions

setting for receiving faxes 125
fax recipient

adding to the Address Book 51

specifying for a PC fax 50

specifying from the Address Book 50
fax report

setting for receiving faxes 125

setting for sending faxes 121
fax settings

defining 119
fax/phone characters

using in the MultiPASS Suite 147
file associations

specifying in the Viewer 108
file name

setting a scan preference on the Toolbar 91
file type

setting a scan preference on the Toolbar 91
filters

despeckling an image in the Photo Enhancer 
115
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flip
an image in the Photo Enhancer 101

folders
moving through images 97

understanding in My MultiPASS 15
forwarding

a fax 59

faxes with a cover page 60

G
gamma

adjusting tone when scanning 84
grayscale

setting for printing 22
group speed dial

setting up 128

H
halftoning method

setting for printing 23
hard disk space

system requirement 2
histogram

adjusting tone when scanning 84
hold

a PC fax 49

I
image

adjusting the color balance in the Photo 
Enhancer 112

adjusting the image type 112

adjusting the orientation 101
automatically adjusting color level in the 

Photo Enhancer 113

blurring in the Photo Enhancer 114

colorizing in the Photo Enhancer 117

cropping in the Photo Enhancer 111

despeckling in the Photo Enhancer 115

displaying in the Photo Enhancer 96

making sepia toned in the Photo Enhancer 
116

manipulating 98
manually adjusting the color level in the 

Photo Enhancer 113

moving through in the Viewer 97

negating in the Photo Enhancer 117

reducing redeye in the Photo Enhancer 115

resizing in the Photo Enhancer 111

rotating 101

setting as wallpaper 108

sharpening in the Photo Enhancer 114
image effects

colorizing in the Photo Enhancer 117

negating in the Photo Enhancer 117

sepia toning in the Photo Enhancer 116
image file

setting a scan preference on the Toolbar 90
image filters

blurring in the Photo Enhancer 114

reducing redeye in the Photo Enhancer 115

sharpening in the Photo Enhancer 114
image optimizer

setting print effects 44
image resolution

setting a scan preference on the Toolbar 91
image source

setting a scan preference on the Toolbar 92
image type

adjusting 112

setting a scan preference on the Toolbar 91
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installation
overview 6
procedures 7, 9
repairing 133

shared printer 13
Internet Explorer

system requirement 2

K
keep on top

setting a Toolbar preference 93

L
landscape

setting the print orientation 25
linked application

setting a scan preference on the Toolbar 90
listen time

setting for receiving faxes 126
load on Windows startup

setting for the Status Monitor 131

M
magnification

adjusting in the Viewer or Photo Enhancer 
97

manual/auto switch
setting for receiving faxes 126

maximized window
displaying the Status Monitor 131

media type
setting for printing 21

memory
system requirement 2

menu
displaying for the Status Monitor 131

mirrored image
when scanning 81

moire
reducing when scanning 81

monitor
system requirement 2

monochrome
setting print effects 43

MultiPASS Service
overview (WinNT/2000) 6

MultiPASS Status Monitor
See Status Monitor

MultiPASS Suite
reinstalling 133

removing 132

software package overview 5
MultiPASS Toolbar

See Toolbar
multiple pages

printing on a single sheet (Win95/98/Me/
2000) 27

My MultiPASS
opening 17

Outbox folder 15

Received Faxes folder 15
renaming a document in a MultiPASS 

folder 17

Scan to Save folder 15

Sent Faxes folder 15

understanding folders 15

N
no answer

setting for receiving faxes 126
number of rings for a fax

setting for receiving faxes 124
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O
off hook alarm

setting for sending faxes 122
on top setting

for the Status Monitor 131
open

document in the Viewer 95

image in the Photo Enhancer 96

the Toolbar 93
operating system

system requirement 2
options

specifying in the Viewer 106
orientation

adjusting in the Photo Enhancer 101

setting for printing 25
Outbox

deleting a fax job 57

My MultiPASS folder 15

sending, resending, holding PC fax 57

stopping a fax job 57

viewing documents 57

P
page layout

printing multiple pages on a sheet (Win95/
98/Me/2000) 27

page size
setting for printing 25

paper size
setting a custom size for printing 27

setting a scan preference on the Toolbar 91

setting for printing 26

setting for receiving faxes 124
paper source

setting for printing 21

pause duration
setting for sending faxes 122

PC fax
attaching a cover sheet 52

creating and sending a fax memo 54

defining print setup 53

holding 49

holding in the Outbox 57

receiving 58

send later 49

sending from your computer 47

sending in the Outbox 57

sending now 49

setting image quality 53

stopping 57
phone characters

using in the MultiPASS Suite 147
phone line

setting for sending faxes 121
photo editor

adding in the Viewer 109

editing properties in the Viewer 110

removing in the Viewer 110

specifying as default in the Viewer 110

specifying in the Viewer 109
Photo Enhancer

adjusting magnification 97

adjusting the color balance 112

automatically adjusting color level 113

blurring an image 114

closing 96

colorizing images 117

cropping images 111

despeckling an image 115

displaying an image 96

flipping an image 101
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hiding/showing the toolbar 98

manually adjusting the color level 113

negating images 117

overview 95

paging through a multipage document 96

reducing the redeye effect 115

reloading images 102

resizing an image 111

scrolling through a magnified image 98

sepia toning an image 116

sharpening an image 114
photo optimizer

setting print effects 44
port connection

changing 134
portrait

setting the print orientation 25
poster

details for printing (Win95/98/Me/2000) 28
preferences

display 96
preview image

scanning in advanced mode 78

scanning in simple mode 76
preview scan image

adjusting in advanced mode 80
print

a document in a Windows application 19

a document in the Viewer 98

document thumbnails in the Viewer 99
Print Advisor

using to define print settings 20
print during spooling

setting (Win95/98/Me) 30
print profiles

saving 44

print quality
setting 21

setting custom 22
print settings

defining manually 20

defining with the Print Advisor 20
print setup

changing in the Viewer 100
printer

reconnecting 132

setting as the default 12
printer cable

system requirement 2
printer control

setting (Win95/98/Me) 30
printer driver settings

setting defaults 46
printer installation

sharing 13
printer paper size

setting for printing 26
printing type

setting for printing 26

Q
quality

setting for printing 21

R
receive in silence

setting for receiving faxes 124
Received Faxes

My MultiPASS folder 15
reconnect

printer 132
reconnect MultiPASS communication

with the Status Monitor 131
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redeye reduction
images in the Photo Enhancer 115

reinstall
MultiPASS Suite 133

reload
a document in the Viewer 102

an image in the Photo Enhancer 102
remote ID number

setting for receiving faxes 127
remote receive

setting for receiving faxes 127
remove

photo editor in the Viewer 110
rename a document

in a MultiPASS folder 17
repair

MultiPASS Suite installation 133
resize

an image in the Photo Enhancer 111
resized image

when scanning 80
reverse order

setting for printing 27
reversed image

when scanning 81
ring time

setting for receiving faxes 126
ring tone

setting for receiving faxes 126
rotate

image in the Photo Enhancer 101

image in the Viewer 101
rotated image

when scanning 81
rulers

when scanning 81

S
scaled image

when scanning 82
scaling

setting for printing 26
scan

with the Toolbar 73
scan preferences

setting 88
scan push button

setting a scan preference on the Toolbar 93
Scan to Save

My MultiPASS folder 15
ScanGear

showing when scanning with the Toolbar 
93

to scan an image 76

working with scan settings 76
send later

on a PC fax 49
send now

for a PC fax 49
Sent Faxes

My MultiPASS folder 15
sepia tone

an image in the Photo Enhancer 116
service pack

system requirement (WinNT) 2
share the printer

cross-platform in Windows NT/2000, 
overview 149

setup 13
sharpen

an image in the Photo Enhancer 114
show a button

setting a scan preference on the Toolbar 89
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show ScanGear
setting a scan preference on the Toolbar 93

simple mode
scanning a preview image 76

simulate illustration
setting print effects 43

software package
overview 5

special characters
when PC faxing or phoning in the 

MultiPASS Suite 147
special tone curve

adjusting when scanning 86
speed

setting for receiving faxes 126

setting for sending faxes 122
speed dial

setting up 127

setting up for a group 128
stamps

creating and changing for printing 32
defining an graphic image for printing 

(Win2000) 37
defining text and color for printing 

(Win2000) 34
defining the text and color for printing 

(Win95/98/Me) 32

deleting from printing (Win95/98/Me/2000) 
40

placement for printing 38

position for printing (Win95/98/Me/2000) 
39

saving for printing (Win95/98/Me/2000) 39

using when printing (Win95/98/Me/2000) 
31

Status Monitor
closing 132

opening 131

using 130
system requirements

to successfully install software 1
system settings

defining 129

T
tone

adjusting when scanning 83
tone curve

adjusting when scanning 86
Toolbar

closing 94

using to scan 73

viewing options 93
toolbar

hiding/showing in the Photo Enhancer 98

hiding/showing in the Viewer 98
Toolbar scan buttons

defining button settings 89

U
uninstall

removing the MultiPASS Suite 132

V
view documents

paging through 96
view images

moving through in the Viewer 97
Viewer

adding a photo editor 109

adjusting magnification 97

changing the print setup 100

closing 96
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displaying a document 95

editing photo editor properties 110

hiding/showing the toolbar 98

overview 95

printing a document 98

printing document thumbnails 99

reloading documents 102

removing a photo editor 110

saving the display 97

scrolling through a magnified image 98

setting the desktop wallpaper 108

specifying a photo editor 109

specifying file associations 108

specifying options 106

specifying the default photo editor 110
viewing documents

in full-screen mode 98
volume

setting up a fax preference 120

W
WAB, See Windows address book
wallpaper

setting from the Viewer 108
warning message

setting for a failed fax transmission 130
Windows address book

creating for MultiPASS 63

specifying a different default 70
Windows startup

setting a Toolbar preference 93
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